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1 Introduction

Congratulations. You now have the right tool for creating a quick, accurate sketch of a crime scene or
traffic accident. With 3D EyeWitness, you can even create a “movie” and "animation" of a crime scene.
You can then use the movie and animation to help with an investigation or as part of team discussions
during pre-raid planning.
With 3D EyeWitness, documenting different types of scenes is easy. With a few clicks of the mouse, you
can create a building, add any revelant furnishings, insert the evidence, and include any revelant notes to
help yourself and others understand the scene. The sketches will awe your colleagues, and can be accurate
enough to use in the courtroom.
To understand the potential of the program, you may want with one of the scenes provided with 3D
EyeWitness. Call up one of the scenes from the library (symbols and bitmaps (WMF) files libraries) . No
matter how rushed or unartistic you feel you are, you can (and will) create scenes like the one on the next
page (or better) yourself.

Starting new scene is easy -no matter how simple or complex the scene in- volved. The basic come first,
such as the building foundation and the walls. Using the icons and the drop-down menus, you can draw and
even modify these building elements in a minute or two.
When the skeleton of the building is ready, you select doors and windows for the relevant rooms from the
corresponding libraries. Connect different floors with stairs if you need to.
Next come the symbols. You may decide to start with the furnishings of the rooms that are significant to
the scene, such as an overturned chair or sofa. You can then add symbols from the special libraries, such as
a gun, to build the scene into a professional depiction of the crime. Or, use the 3D Modeler to create or
modify a custom symbol and place than in the scene.
Finally, add roofs, text and dimensions to complete the scene. The resulting 3D view could look like the
one on the next page.
Even easier is an outdoor scene, such as a traffic accident. All you need to do is open the symbol libraries
and choose from one of the pre-drawn symbols. You choose the symbol with a click of the mouse, and then
place it in the scene with a second click.

1.1 Inside 3D EyeWitness

The 3D EyeWitness product includes the following:

Menu  and  Icon-Driven  Drawing  Program: This  software  allows  you  to create a professional sketch
of a scene quickly. You can execute the necessary commands either with a mouse or from the keyboard.
Online Help is available when needed.

Pre-Drawn Building Elements: The elements you use to create a scene have been pre-drawn by
professionals and compiled in libraries. You pick an element from a library, set its parameters (such as
size and color), and place it in your scene.

Viewing in 3D, animation: 3D EyeWitness gives you several viewing options when you create an external

or internal view of a scene. You can decide to display the entire scene, or one level at a time, and you can

rotate the view to see it from any angle.

Avatar Movie maker: You can create movies with AVATAR people and actions.

Modeler Software: Use this functionality to create or modify your own symbols and libraries.

Terrain Designer: The 3D EyeWitness Terrain Designer makes it very easy to create a terrain on your
scene. The Terrain Designer automatically generates terrain or allows you to manually create or edit terrain
and view the results in 3D.
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Road Designer: The 3D EyeWitness Road Designer makes it very easy to create and place the roads
on your scene. The  Road Designer automatically generates roads or allows you to manually create or edit
roads and view the results in 3D.

Roof Designer: You can generate a roof with the automatic roof designer

Stair Designer: You can generate a stair with the automatic stair designer

User’s Manual: 11 chapters to help you along the way.

Registration Card / Order number: Fill out and send in this card / or authorize to receive free
technical support, notice of upgrades, and other special offers.
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2 Installation

This  chapter  outlines  the  recommended  system  setup  for  installing  3D EyeWitness. The second
section provides the few easy steps required to load the software.

2.1 Software key authorization

In order to run this program, you must receive authorization from DesignSoft.
When you first run the program, a message box appears showing your initial authorization status. If you do
not receive authorization, you are normally limited to 31 sessions to try the program. 

At the end of the trial period – but preferably as soon as possible – do the following:
Run the Help.Authorization. Authorize menu. The Authorize message box appears:

If you have received your program with a 16 digit Order number you can authorize your program in 3
simple steps described in the dialog box above.

It may be that your firewall does not allow your program to connect to the Internet. In this case you will get
the following messages

If you are connected press OK. The following dialog appears:

Press Yes. Your Site Key will appear in a browser. Copy and Paste this into the Authorization dialog of
your program.

If you do not have an Order number, or it does not work for any reasons or you do not have Internet
connection, then click on the Other tab on the top of the dialog box. The Other page of the Authorize
message box appears:
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This dialog shows your personal Site code, which identifies your computer.

Record and send your Site Code and your Order number to DesignSoft by email or using the given web
address. Always use Copy and Paste when you need to copy these information from one field into another.

If you have received the program on CD, the Order number is provided with the CD. If you receive the
program as download it should be included in the email containing the download link.
 
Note, that if you click on the email address above, your default email program starts using an initial email
template, that already includes both the Order number and the Site key.

If you prefer, you can click on the http://www.designsoftware.com address and select Registration on top of
the screen, where you can enter the necessary information. 

Whichever option you choose, make sure you give us your 
- Site Code
- Order Number and
- your email address
so that we can send you your authorization code (site key).

If you contact us by email or via the web, you will shortly receive an acknowledgement of your transaction
by email. If you haven’t received this acknowledgement very soon, perhaps you mistyped your email
address, so you should re-send the information. Within a few working days, we will send you your site key
by email.

When you receive your Site key, run the Authorize menu again, enter the Site key into the Site key field,
and press OK.

If you want to move your authorized program to another computer, use the commands “Transfer using
removable media” or “Transfer using Internet” from the Help.Authorization menu. The default password
of these commands is ProgramProtection. For more information see the Help of the Authorization dialog
and check Transfer License. 

2.2 Hardware  keys (USB or parallel dongle)

Do not insert your USB device before installing the software.

Installing the USB device 



3D EyeWitness16

DesignSoft

When you install the software, the driver needed for your USB key is installed as well. 
After installation you will need to restart your computer.
After installation, when your USB key is first plugged into the USB port, the system will ask you to
identify it.
Choose:

· Look for software associated with the USB stick, then

· Install software automatically, then

· OK/Next.

Do not insert your USB device before installing the program!

2.3 System requirements

Minimum hardware and software requirements:
· IBM PC 586 or compatible
· 1 GB of RAM
· A hard disk drive with at least 500 MB of free space
· Microsoft Windows XP/Vista/7/10/11 or later

Recommended configuration:
· IBM PC Pentium or compatible
· 2 GB of RAM
· A hard disk drive with at least 2 GB of free space
· Microsoft Windows 11 or later

OpenGL 3D:
· ASUS TNT2 accelerator
· (800*600 or higher DPI resolution)
or 
DirectX v9

2.4 OpenGL video card

The software uses the OpenGL or DirectX system when running 3D graphics. 
To run the software properly you should have the card's latest driver installed on your computer.
This can be downloaded from the website of the card's manufacturer.
When running 3D graphics it is possible that the software does not support your computer's OpenGL card. 
In this case you may deactivate the graphics card as follows:
v In 2D mode: within the 3D menu click 3D parameters, then choose OpenGL/Software.
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3 The Basics

This  chapter  describes  some  fundamentals  you  need  to  start  using  3D EyeWitness for Windows

quickly and easily. These include:

ź Looking at the 3D EyeWitness window 

· Understanding distances in 3D EyeWitness 

· Working with Windows

ź Entering data 

· Handling files 

· Viewing scenes 

· Using help

3.1 Looking at the 3D EyeWitness Window

To open 3D EyeWitness in Windows, click the Start button, select Programs, then 3D EyeWitness for

Windows, then  3D EyeWitness. You will then have access to the 3D EyeWitness drawing screen.

There are four elements on this screen, as shown on the next.

2D window
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Menu bar: 

3.1.1 Drawing Area

This window is where you draw, edit, and view your sketches. Tasks are accomplished by a few clicks of
the mouse and movement of the cursor. Note that to enter elements, you have the option of clicking and
holding down the left mouse button as you drag the mouse. You may be familiar with this approach from
working with other Windows programs.

3.1.2 Menu Bar

The menu bar contains eight options. Click on an option to see the drop-down menu associated with it. For
example, clicking on Draw opens a menu containing everything you can insert into a design.

One way to move around 3D EyeWitness quickly is to click (or drag) the mouse through a series of menus.
Menu commands followed by an arrow open sub- menus. Commands followed by ellipses (...) open dialog
boxes. Click the mouse through the menu series. Continue until you reach the final menu item you want.

Note that you can also pull down the menu associated with any option on the menu bar by pressing ALT-
key, where “key” is the underlined letter in the name (such as F for File).

Note: The drawing area shows one floor, or level, at a time. When you open a new file, the drawing
area shows Floor-0, by default. The name of this level appears in a tab at the bottom of the
drawing area. If you add additional levels, you will see more tabs on the bottom of the drawing
area. Click on the tabs to move between floors.
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3.1.3 Toolbars

Another way to move around 3D EyeWitness quickly is to click on the toolbar buttons. There are two
levels of buttons: those in the toolbar across the top of the screen, and those running down the left side of
the screen. The top-level buttons include those shown below.

Note: To check the name of a tool, move the mouse over the button. A tool tip appears with the name of the
button.

 

     File/ New, Open, Save

     Print, Print preview, Print to PDF

   UNDO / REDO

 Cut, Copy Paste

 Selection tool  Move selected objects with cursor arrows

 Walls  Dimension lines

 Columns  Drawing tools    

 Windows   Drawing tools

 Doors  Folie manager

 Slabs  
Redraw, Zoom  functions

 Roofs  2D Air view

 Stairs  3D External view     3D Internal view

 Symbols, SKP symbols   AVARTAR Animation

 Rails  3D Movie player

 Animated symbols                                Help

 3D Modeler

 Road Designer                     Terrain Designer

 Roof designer                    Stair Designer

 
As you drag the mouse over the primary bar, the coordinate line at the bottom of the screen indicates the
purpose of each button. Clicking one of the toolbar buttons opens up a secondary set of buttons on the left
hand side of the drawing area. These relate specifically to the task at hand - if you click on the Slab button,
for example, a button for each of the two possible slab shapes appears to the left. You use these buttons as
shortcuts for inserting, modifying, enhanc- ing, and viewing your designs. More detailed information on the
role of each button appears later in this manual.
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3.1.4 Coordinate Line

The line directly under the drawing area is the coordinate line. Look in this line for data about the
positioning of design elements.

x and y: 3D EyeWitness defines the position of the cursor on the screen through a coordinate system (see
“Working With Dimensions” coming up in this chapter).   The y value defines the amount of movement up
and down relative to a fixed point, and the x value defines the amount of movement sideways. Use these
values when positioning design elements.

d: (Length): Length data is provided only for walls. After you click to define the first endpoint of a wall,
the distance the cursor travels from that point is shown here.

a: (Angle): If you are inserting a wall, its angle is indicated here.

 Origin Placement: Press F5 to toggle between absolute and relative placement of the origin of the
coordinate system. Absolute means that the origin remains at the lower-left of the drawing area. Relative
means that the origin  moves  to  the  first  endpoint  of  each  new  design  element,  as  you anchor it.

Messages: Information about the current action is displayed to the left on the coordinate line.

3.1.5 Key combinations

Shift, Ctrl During editing holding down Shift or Ctrl enables you to introduce new elements in an
orientation of 0,45,90,... degrees, by allowing you to change you orientation by 45 degrees. 
Space When drawing a wall, pressing Space modifies its thickness relative to the red rubber line. 
Pressing space also toggles between superimposed elements to assist in selecting them. In the case of
columns, slabs, symbols, (polygons) etc., you can move between the corner and center points of the
elements by pressing Space.
The key combinations for all functions that may be carried out with shortcuts are listed next to the function
names in the various menus. 

2D 3D MODELLER
Shift Moving along a 0,90 degree line,

minimal step size 1 m
Moving along
a 0/90 degree
line

Ctrl Moving along a 0, 45, 90 degree
line. When inserting
doors/windows: press down Ctrl
and change the size of the
door/window

Move along Z
axis

Ctrl+Alt Open the settings dialog of the
selected object.

Shift+Ctrl Editing along a predefined axis.
Space Changing between elements

superimposed upon each other
(you have to first select one of
them).
When drawing a wall: manual
adjustment of the wall's
thickness.

Changing between elements
superimposed upon each
other (you have to first
select one of them).

x,y,a,d Jump to Coordinates line, data
entry

data entry data entry

Ctrl+F3 File/Open
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Ctrl+F2 File/Save
Shift+Ctrl+F2 File/Save as...
Ctrl+P Fájl/Print
Alt+F4 Fájl/Exit Exit Exit
Alt+1 Go around the

building 
Alt+2 Film mode 
Alt+BkS Undo Undo
Shift+Alt+BkSp Redo Redo
Ctrl+X Cut Cut Cut
Ctrl+C Copy to clipboard Copy to

clipboard
Copy to clipboard

Ctrl+V Paste from clipboard Paste Paste
Ctrl+Del Delete/Remove
Ctrl+A Select all
Ctrl+N Select next
Ctrl+S Deselect

Ctrl+O Switch on orthogonal editing 
(editing along a defined axis) 

Switch on
orthogonal
editing

Switch on orthogonal editing

Ctrl+F Open foils
Shift+F Open level foil 
Ctrl+G Switch on/off grid
Ctrl+ (W,E,L,D,
Z,+,-), F2

Zoom Zoom Zoom

Ctrl+E Zoom to extent Zoom to
extent

Zoom to extent

3.1.6 Function keys

Use function keys or key combinations to change between units or states, or to perform specific operations.
The function keys are the following:
F1 Help.
F2 Automatic magnifier: an area of approximately one square meter around the drawing pen or
selection arrow will be magnified to the size of the whole design window. Press F2 again to return to the
original scale.
F3 Setting step distance: In the default setting, the software allows you to move your cursor in
millimeters. Press F3 to change into centimeters. Pressing F3 again returns the units of measurement to
millimeters. 
F4 Zeroing coordinates and relocating the relative coordinate system: The coordinates can be seen at
the bottom of the design window. To zero the coordinates, press F4. The origin of the coordinate system
will be relocated to the cursor's current position, indicated by the appearance of a small red cross.  The
elements are then re-matched. Most functions (e. g. drawing new walls) will allow for this option, treating
the given point as a new origin when removing the cursor. Thus, after selecting the starting point for a new
wall, the second point will be represented in the coordinate system relative to the first one. Pressing F4 to
specify a new origin for the coordinate system.

Note: If the Snap function is on, pressing F4 also invokes a re-matching of elements, readjusting the
crosshairs to the element which is within the range specified in the Snap adjustments.
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F5 Changing between the absolute and relative coordinate-system Press F5 to switch between
coordinate-systems. The origin within the absolute coordinate-system is the upper left corner of the design
window. It is not advised to begin your project from the absolute zero point. At the beginning of a new
project, the software offers an area of 30.000 by 30.000 cm as the site to start your project. You are able to
create your project in an area extending approximately 500 meters in both directions. 
You can easily return to the absolute origin point by using the scroll bars.
F6 Reload screen

2D 3D MODELER

F1 Help Help Help

F2 Automatic zoom

F3 Adjust minimal step of movement Adjust minimal step of
movement

Adjust minimal step of
movement

F4 Set coordinates to 0 and reposition
point of reference (of relative
coordinate system)

Set coordinates to 0 and
reposition point of
reference

Set coordinates to 0 and
reposition point of reference

F5 Change between relative and absolute
coordinate system

F6 Refresh screen

3.2 Understanding Distances in 3D EyeWitness

3.2.1 The Cartesian Coordinate System

3D EyeWitness uses a Cartesian coordinate system to help you locate exact points while you are drawing
and to measure distances accurately. This means that the program defines the position of the cursor relative
to the origin point of an x,y axis. Touch the screen with your finger. Think of that point as the origin, or
center, of an imaginary x,y axis. Any point above your finger has a positive y value; any point below your
finger has a negative y value; any point to the right of your finger has a positive x value; and any point to
the left of your finger has a negative x value.

When you begin a design, the origin of the coordinate system (0,0 point) is by default placed at the lower
left corner of a large drawing area (32000'x 32000' or 10000x10000m). By default, the drawing window
displays only part of that area (130'x 80' or 40x25m, depending on screen resolution). You can use the
scroll bars or the Zoom function (outlined later in this chapter) to move around the drawing area.

If you press F5 for absolute placement of the origin, the origin moves to the lower-left corner of the
drawing area. In contrast, if you toggle back to relative placement by pressing F5, the origin will move to
the first endpoint of any element you insert.

You can also manually set the placement of the origin with the  F4 key. Place the cursor where you want
the origin to be and press this F4 function key.

How do you use the Cartesian coordinate system to help you design your sceen? With the x,y axis, you can
precisely indentify the position of any point in the drawing window. As a result you can ensure that:

The endpoints or cornerpoints of two building elements coincide exactly.

A building element is drawn with the exact length and angle required. Scene elements are correctly placed
relative to each other.
Another function in 3D EyeWitness provided for aligning building elements is the snap-to-grid. This grid is
represented by light blue dots in the drawing window. You can have the endpoints of building elements
snap to the grid points when you draw them. You can, of course, change the size of the grid. This function
is explained in more detail later in this manual.
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3.2.2 Data entry

When introducing new elements you will need to enter data specifying the element’s characteristics. The
entered values are to be understood in the unit of measurement specified in the relevant option.  

You can specify or modify the position (or size) of an element you are editing by pressing X, Y, a  or d
 and entering the desired values in the fields. 
After pressing one of these button the software switches into data entry mode and in the fields dX, dY, a, d
and you can enter values for a shift of X and/or Y, for an angle of a, or a length of d. 
Do not move the mouse during data entry, as this overwrites the entered data. 
The entered values can refer to:
· a corresponding movement of the drawing pen,
· a data needed for an element that is being edited, such as the second point of a wall-section,
· a shifting value of one or more selected elements. 
The entered values will be applied relative to the reference point shown by the small red crosshairs. 
The data in dX, dY and a, d are interrelated, thus entering two values and pressing Tab or Shift+Tab results
in the software calculating the other parameters. By pressing Tab you can also enter the field level height

 or  , where you can overwrite the previously specified level height value.

3.2.3 Rapid data entry and visualizing the coordinates of the cursor

Click on View/Mouse coordinates to visualize the coordinates of the cursor. Click on an element and its
properties will appear in a semi-transparent dialog. Press Ctrl and Alt to activate this dialog and modify
the parameters of the selected element quickly and easily. 

 

3.2.4 New items and functions in right-click menus

New items have been added to right-click menus. Select an element and click right to see them. These
items make editing even faster. 

3.3 Manually Entering Coordinate Values

Besides clicking and moving the mouse to insert a building element, such as a wall, you can manually enter
specific coordinate values for that element. For example, let’s say you have clicked the mouse to anchor
one endpoint of a wall.  Now,  hit  the  “X”,  “Y”,  “a”  or  “d”  key  on  your  keyboard. The  data entering
fields are shown on the next page.

Type a value for one or both coordinates and hit “Enter”. The wall is drawn to the dimensions you chose.
Hit “Enter” again to anchor that second endpoint. Moving the mouse before you hit “Enter” the second
time will change the coordinates of the second endpoint.
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dX: The X distance of the mouse cursor from the reference point 
dY: The Y distance of the mouse cursor from the reference point 
a: The angle of the ref.pt-mouse cursor vector and the X Axis
d: The distance of the reference point and the mouse cursor

Note:  If  you  move  the  cursor  after  you  anchor  the  first endpoint of the wall, the x and y values of the
cursorposition will  not  be  added  to  those  you  type  in  the  Coordinates dialogbox.

The icons used for matching are as follows:

3.3.1 Snap

  Snap ON/OFF, Snap grid, Snap objects,
Snap to large objects, Snap intersection points, Snap objects on Level Folis

Click on this icon to switch the corresponding algorithm On/Off.  Switching on the matching option will
enable you to snap to the grid points  and elements  present  on  the  screen. These  points  will  become 
so-called  “ hot-points.” As you move the cursor above them, the cursor will change shape - 
“+”: you are close to a grid point
“White pipe” : you are moving over a certain element (wall, slab etc.)
“Black pipe” : you are moving over a corner of a polygon or endpoint of a wall.
"small rhombus" :  means that you are above the area of a polygon (e. g. slab, symbols, roof, column)
The symbol indicates in advance what kind of snapping you are about to perform: a cross indicates
snapping to grid-points, pipe indicates snapping to object points, etc. 

Snapping settings can also be set in the dialog box opened by Options/Snap. 
You can redefine the precise position of your cursor as the origin of the coordinate system by pressing F4.
This can be seen by zeroing the dX and dY fields and relocating the small red cross which shows the origin
of the current coordinate system.
Distance: n pixel.  The snapping is carried out according to the values entered here. The entered values
refer to pixels, taking into account screen resolution.
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3.3.2 Rotation of the coordinate system

This function allows you to rotate the coordinate system and the raster.

 Clicking on this icon lets you set the direction of the rotation. You can rotate the system of co-
ordinates:

· in the orthogonal direction by selecting Ortho.

· by a given angle if you type in a certain value for a: (Angle)

· in  any  given  direction  if  you  choose  2  points  on  the  screen  which define the requested direction

· by typing in a certain value in the   “Direction X,Y”   fields you can define the angle of the rotation: it’s
enclosed by the x-axis and the line between the origin and the given point

· by typing in a certain value in the  “Position X,Y” fields you can define a point around which the system
of co-ordinates can be rotated

There are a number of drawing tools to help you draw with orthogonal, parallel, or bisector constraints.

3.3.3 Drawing tools with Constrains

 

Press the Constraints button  to invoke the Constraints toolbox to help you draw with orthogonal,
parallel, or bisector constraints.

Move by Grid: The drawing pencil can only be positioned on grid points. The distance of the grid points
can be altered in the Option/Change Grid dialog box.
Move by Unit: The drawing pencil can be positioned on grid points or according to a cm/inch unit/scale as
defined in the Option/Change Unit dialog box. You can select another unit (mm, 1/16 inch) by pressing the
function key F3. If you push F3 again, you will return to the unit originally used.
The sensitivity of snapping can be changed in the Option / Snap dialog box.

Note: If you press  F4, the origin of the coordinate system will be moved to the current position of
the cursor.

3.3.4 Drawing parallel to the coordinate axes

  Press this button to force the cursor to only draw parallel to the coordinate axes. This is very useful for
drawing walls. The tool can be switched on and off by pressing the Ctrl O hotkey  (O for Orthogonal).

  Click on this icon to move and draw along the coordinate system's two axes. For example, in the case
of walls you can easily and accurately create horizontal or vertical wall sections using this feature. This
option can be switched on/off by clicking on the icon, by pressing Ctrl+O, or by clicking Ortho in the
Options menu.
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Pushing the   icon enables you to move parallel to the X/Y axis of the coordinate system or to a given
line. The parameters of this option (Angle snapping) can be adjusted in the dialogue found at
Options/Angle snapping settings.

Division number (x): 360/x=30. With the help of this option you can put constraints on the orientation of
new wall sections (and other linear structures). For example, set 12 as the division number and new walls
(lines, etc.) will have an orientation as described on the dialog.
    Tolerance values ( ± ): Set this option on and the software will automatically adjust walls (and other
structures) if you move them within a range of the predetermined angles. That is, if the division number is
set to (eg.) 12 and this option to 2 degrees, then if you move a wall section to an orientation of 30 degrees,
it will automatically switch to 30 degrees. Tolerance values can be defined in degrees or in absolute
distance. Use the small pipe that appears next to the mouse to select which of the latter two options you
want to use.

    Note: To draw lines (wall sections etc.) with an orientation of 90 (180, 270) OR 45 (90, 135 etc.) 
degrees press down Shift 90 (180, 270)   OR   Ctrl 45 (90, 135 etc.). To draw lines with the orientation
defined as described above, press down Shift    AND   Ctrl 30 (60, 90, 120.. etc.).

    Note: Pressing Shift or Ctrl while inserting an element allows you to draw along the four axes (Shift) or
by 45 degrees increments (Ctrl).

3.3.5 Drawing parallel to a given direction

 Press this button to force the cursor to only draw parallel to a given direction. This is very useful for
drawing wals parallel to other walls.
To use the tool, press the Parallel constraint button then click on a wall or any two points defining the
direction. Now when you draw a wall or a line, it will be parallel to the given direction.
v select an element (eg. a wall) which provides the line's orientation
v specify a line by selecting two points on the drawing area.

For example, to place a wall parallel to a given wall: 

1. select  the first point of the wall

2. click the parallel constraint icon

3. select the wall to which you wish the new wall to lie parallel to

4. place the wall’s second point

Note: The Snap button must be on if you want to define the direction by clicking on a wall.
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3.3.6 Perpendicular drawing tool

 Press this button to force the cursor to only draw perpendicularly to a given direction. This is very
useful for drawing walls perpendicular to other walls. To use the tool, press the Perpendicular constrain
button then click on a wall or any two points defining the direction to which you want to draw
perpendicularly. Now when you draw a wall or a line, it will be perpendicular to the given direction.

Note: The Snap button must be on if you want to define the direction by clicking on a wall.

3.3.7 Bisector of the angle drawing tool

 Press this button to force the cursor to only draw along the angle bisector line between two previously
given lines.
To use the tool, press the Bisector of the angle constraint button, then click on a point of the first line and
then to a point on the second line that defines the angle.  Now when you draw a wall or a line, it can be
drawn along the bisector only.

3.3.8 Drawing parallel to a given direction with a given distance

 Press  this  button  to  force  the  cursor  to  only  draw  parallel  to  a  given direction  with  a  given 
distance. This  is  very  useful  for  drawing  walls parallel to other walls.
To use this tool, press the Parallel constraint with distance button, then
click on two points defining the direction. Next, establish the Reference line positioning. Click on one
point of the reference line and the line will be drawn. This can be useful when you want to draw the wall
with a given distance from a certain place on the floor plan.
Next, define the distance by pressing the Y key, entering the value, and pressing Enter. Now you can draw
the required building element.

3.3.9 Circle constraint

 Click on this icon
Draw a circle
Select the icon of the drawing element
Draw the element from any point of the circle

For example, to place a wall on a circle: 
1. Place the first point of the wall
2. Click the circle constraint icon
3. Draw a circle
4. Place the wall’s second point-- this second point can be on the circle.

For example, to place a wall on a circle: 
1. Click the circle constraint icon
3. Draw a circle
2  Place the first point of the wall -- this first point can be on the circle.
4. Place the wall’s second point-- this second point can be on the circle.
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3.3.10 Projection tools (Projection mode determination)

 

 Use these tools if the end point of a building element (wall, line etc.) is determined as a section of
the given direction of the element and a projec- tion line from a specified point on the floor plan. The
projection line can start from any point you click, and its direction is determined as follows:

1.    Perpendicular: perpendicular to the element

2.     Horizontal: parallel with the x-axis

3.    Vertical: parallel with the y-axis

Example: Assume you want to draw a vertical wall on the screen with an endpoint of the same Y-
coordinate as another point of the building. Make sure the Orthogonal constraint button is on and move
the cursor to the required point. Here, the Y-coordinates of the wall and the required point will be the
same. Click on the point to finish drawing the wall.

3.3.11 Methods of division

 We can choose between several dividing systems to subdivide the structural elements located in the
plan. The division points can be used as matching points.
Dividing methods:
1.   Divisions: divide by the number of subdivisions
2.   Distance: set the length of the subdivisions
3.   Percent: set the ratio of the subdivisions in percentage

The little lines appearing at the division points can be created by pressing the right mouse button and
selecting the Lock division points function in the menu.

3.3.12 Using Zoom

Using the Zoom commands from the View menu, you can increase or decrease the amount of space
represented within the drawing manual. For example, if you choose Zoom Out / Ctrl - , your plan will
become smaller and you’ll see more of the drawing area. You can continue to draw and modify your design
in this zoomed view.

3.4 Working with Windows

If you are familiar with other Windows programs, most of the commands under  the  File,  Edit,  and 

Window  menus  in  3D  EyeWitness  need  little explanation. For help, see your Windows documentation.

Some 3D EyeWitness- specific aspects to these commands are noted in the following descriptions.
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3.4.1 From the File menu

New: Use this command to open a new, blank drawing window. Remember to save any project you are

closing if you want to.

Create a new level

 Line drawing: Open a new window for an LDR drawing. This opens a blank drawing
sheet where you may create a line drawing which may be saved as an LDR file.

   Create a new scene (*.MYH)

Create a blank drawing sheet (*.DRS file)

Create your own drawing template (*.TPL file). You can place here a frame, your
company stamp, or any other information. Drawing templates prepared this way can be used
later as your own drawing sheets. When you save your own template,  you  can  assign  a  title  and 
one  of  the  following  icons  to  it (*.DRS file) . 

 A4: Open a pre-set A4 drawing sheet template. 

After specifying the icon and title a icon with the title will be created and shown under the File/New

command.

You can open the required drawing sheet by clicking the appropriate icon.

Open: By default, the Open command looks for files in the Project subdirectory of the  3D EyeWitness

 directory. (c:\3D EyeWitness vn\project)

3D EyeWitness files carry the extension .myh; this extension is selected by default in the Open dialog
box. To open files from earlier versions of   3D EyeWitness, you’ll need to change the “Files of type” in
the Open dialog box.
Close: Use this command to close the project.
Save and Save As: By default, files are saved with an .myh extension. When saving a new project for the

first time, use Save As. When saving your work on a project as you go along, use Save.

Print: Use this command to set printing options and then print your 2D designs. You can choose to
print the entire drawing, or only what appears in the current drawing area. You can also select from a wide
range of scale options as well as other options to enhance your printout.
Export: Use this function to save projects as .dxf extension files. You can then import your plan into

AutoCAD for plotting.

Bill of Materials: Use this command to open the automatic bill of materials spreadsheet. 
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3.4.2 From the Edit menu

Undo: Use this command to erase work you have just performed. The Undo command is unlimited so you

can erase as many elements or commands as you have performed in a work session, in reverse order.

Redo: This command will redo any work that was just undone. Like, Undo, this command is unlimited.

Cut, Copy, Paste: Select a design element or elements, and then choose one of these commands.

Anything you select with the Cut command is copied to the clipboard. If you then choose the Paste

command, a rectangle appears on the screen. Move the rectangle with the mouse and click to anchor.

The cut material reappears.

Delete: Select a design element by clicking the Pointer icon and then clicking on the element. Once that

element is highlighted, use this command to delete the element.

Select All: This  command  selects  all  the  design  elements  in  the  drawing window. You can now

perform editing commands on these elements as a block.

Note: you can select a group of design elements by clicking the  Pointer  icon  and  clicking  and 
dragging  to  create  a selection box. All elements completely within the box will be highlighted.

3.4.3 Using the Mouse

Using the mouse to perform the commands in 3D EyeWitness is the fastest way to create your design.

Much like other Windows programs, use the mouse to move the cursor in 3D EyeWitness. Click and drag

symbols to their new positions, click walls into place, double click on elements to change their pa-

rameters, and click on the    horizontal and vertical scroll bars to move to other sections of your drawing area.

Note: In most cases, the cursor in 3D EyeWitness can be moved by moving the mouse or by
using the arrow keys on your keyboard.
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4 Quick Start

4.1 Tutorial

This chapter takes you through the basic steps required to create your sketch. By following along, you

will create a murder scene in the room of a house. When you are through, your sketch will be similar to

the one shown below and you will be ready to start creating scenes on your own.

Let’s begin:

4.1.1 Draw a slab

We will start with the floor of the house, called a slab in 3D EyeWitness. Select Slab from the Draw

menu. Drag the mouse to the right and select Rectangle from the pop-up menu. Or, click the Slab icon on

the top toolbar, then the Rectangle slab icon on the secondary toolbar that appears on the left.

Position the cursor, which should now be a set of crosshairs, in the upper left  hand  portion  of  your 
drawing  area  and  click  once. Then  drag  the crosshairs towards the opposite corner of your drawing area and
click again to lock in that corner. Your drawing area should now have a rectangle in it. Make sure the
rectangular slab is quite large as we will be adding scene elements to it. If you are unsatisfied with the
slab you have created, select Undo from the Edit menu and start over.
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4.1.2 Draw exterior walls

Select Wall from the Draw menu. Drag the mouse to the right and select Rectangle from the pop-up

menu. Or, click the  Wall icon, then the fourth icon  down on the secondary toolbar.

Place the cursor over the upper-left hand corner of the rectangular slab you just created and click once. Drag

the cursor to the opposite corner of the rectanglar slab and click again.

Shift Hold down when drawing a wall or other element in order to change your
orientation by 90
Ctrl Hold down when drawing a wall or other element in order to change your
orientation by 45
Shift+Ctrl Hold down when drawing a wall or other element in order to change your
orientation by defined (x) angle in Ortho dialog 

4.1.3 Draw interior walls

Select Wall from the Draw menu. Drag the mouse over and select Single from the pop-up menu. Or,

click the third icon down on the secondary toolbar.

Move the cursor to the inside edge of one of the exterior walls you already created. Click to anchor the first

endpoint of the wall, then move the cursor until you are satisfied with the wall’s length. Click to anchor this

second endpoint.

Note: If your walls are not being drawn at right angles to each other, select Ortho from the
Options menu ( or CtrlO ).

Continue drawing interior walls until your sketch looks like the one below.

4.1.4 Draw doors

Select Door from the Draw menu. The Door library will open on the right hand side of your drawing area.
Click on Door/1 in the Door library. Then, place the cursor on a wall in your scene and click. A rectangle
appears, representing a door. Move the cursor to slide the door along the wall and click again to anchor the
door.

Repeat these steps as desired to place doors throughout your scene. If you want to use the same door style,

it is not necessary to reselect it from the library. If you want to choose a different door style, select it from

the door library and place it following the steps described above.
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Note: To change the swing style of a door, press Ctrl and click one of the second any toolbar
icons on the left while the door is highlighted on your screen.

4.1.5 Draw windows

Windows are placed much the same way as doors in 3D EyeWitness. Select Window from the Draw menu.

The Window library will open. Click on the window you want to place in your scene. Then, place the cursor

on one of the exterior walls in your scene and click. A rectangle appears represent- ing the window. Move

the cursor to slide the window along the wall and click to anchor the window where desired.

Keep placing windows so that your sketch resembles the one below.

4.1.6 Insert symbols

Select Symbol from the Draw menu or  icon, and drag the mouse to the right to open the library

you want. For this tutorial, select Sablon. The sablon symbol library will open. To place a symbol in

your scene, click on the desired symbol and drag the highlighted outline of the symbol to where you

want to place it. Click again to anchor the symbol. Once the symbol has been placed, the highlighted

outline will remain. Click to enter the same symbol again or click the right mouse button to eliminate this

outline.
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You can also open up the symbol libraries by clicking the  Symbol icon on the top toolbar, then

clicking the desired library icon on the secondary toolbar that appears on the left-hand side of the drawing

area.

Note:  To  rotate  a  symbol,  hit  the  “plus”  or  “minus” (+, -) keys on your keyboard or 
icons while the symbol is high-lighted in blue. To rotate a symbol that is already in your scene, 
click  the  pointer  icon,  then  click  and  hold  the mouse button down on the symbol you want to

rotate. Hit the ”+” or “-” keys  or  icons. Release the mouse button after the symbol has
been rotated.

After placing your symbols, you are ready to crime scene symbols. You do not need to close the Sablon

symbols library to access the Crime symbols library (  icon). To open the Crime symbols library, click

the down arrow next to the library name. The other library choices will appear. Highlight the Crime library

and click to open it. Or, click the  Crime library icon on the secondary toolbar.

Select a corpse and rotate it, then place it in your scene. Next, select a murder weapon and place it in

your scene. You can also add a pool of blood, bullet holes, or other symbols from the Crime library to

complete your homicide scene.

Your resulting scene should be similar to the one shown on the next, depending on what symbols you

placed and where.

4.1.7 Insert SKP symbols

 The program enables the use of SketchUp files in the library. A multitude of pieces of furniture and
other useful symbols are available on-line, modeled and stored in SKP format. These elements can be used
with the help of the program. 

Libraries can be formed from the SKP files (Settings/SketchUp symbol). From the libraries created
in this way the symbols are easy to place in the building. In the course of filing in the library the program
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produces the symbol’s painted and linear view, from which the user is free to choose and use on the floor
layout plan.

The SketchUp symbols can be placed on the floor layout plan after selection from the library. The
presentation on the floor layout plan may be the linear view or the painted image generated in the course of
filing in the library and its viewpoint can also be changed. It can be specified by setting Show as image
and the Upper/Front/Right/Left/Rear view in the dialogue. It can be modified by View/ ... upon right-
clicking on the symbol marked. The symbol’s size and horizontal shifting can also be set.

03- SKP library  2_en - SKP library  

4.1.8 Insert AVATAR symbols

      

The objects to be used in the AVATAR animation can be taken from the Avatar symbol library. These
symbols (people, functionaries, fire water and alarm sign) may be resized, given actions, and otherwise
modified. It is also possible to animate these symbols moving along a path and using the ACTIONS
parameter(CVILS and FUNCTIONARIES libraries). To do so, the path must be determined on the floor
plan. 
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FIRE and WATER elements: 
To place a symbol in your scene, click on the desired symbol and drag the picture of the symbol to
where you want to place it. Click again to anchor the symbol. Once the symbol has been placed, the
picture will remain. 
New items have been added to right-click ACTIONS menus. Select the  element and click right to see it.
These items make editing even faster. 
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You can run the AVATAR modul, click on the  icon.

4.1.9 Add a roof

Select Roof from the Draw menu. Drag to the right and select Roof from the pop-up menu. Or, click the

 Roof icon on the top toolbar and then the second icon down on the secondary toolbar. The roof

library will open. Select “Roof 1A” from the Roof library. A rectangle appears, representing the roof.

Position the rectangle over the house and click the roof into place. Then, click the right mouse button to

cancel the highlighted roof outline.

4.1.10 Automatic roof designer

 

Click on the  icon, then draw the polygonal structure of the roof. Select from the right click menu
whether you want to draw the shape of the roof or have it automatically generated (along the external edges
of the building) by providing a reference point.

You can also switch on the feature Room or building shaped  (also found in the right click menu).
When this feature is activated you need only click on an outer wall of a building, and the room is
automatically created along the walls. 

 If you switch off Room or building shaped you need to draw the shape of the roof yourself. 
When Snapping is turned on, drawing the roof is facilitated by the appearance of black pipes. After
designing the polygonal shape of the roof, the Automatic roof designer appears. Set the roof pitch and
choose from various roof types: (normal, hip roof, with gable, etc).  The roof pitch is the same all along the
roof. However, along the edges of the roof, additional parts of a different orientation can be attached.
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Automatic Roof Designer

4.1.11 Save your scene

To save your 3D EyeWitness scene, select  Save As from the File menu. Give your sketch a file name (for

example: Crime). Click “Save.”

Your scene is now saved as “Crime”. To check this, select Open from the File menu. Your file should be
listed. Once your sketch is given a file name, you can save it automatically while working on it by
pressing the “Ctrl+F2” key. It is a good idea to save your sketches often.

4.1.12 View in 3D

One of the reasons for using 3D EyeWitness is to view your sketch in 3D. To view your sketch in 3D

from the outside, select External View from the 3D menu. Or, click the 3D-External View icon.

3D-External View icon
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A message appears indicating that the 3D generation is in progress. The amount of time it will take to

generate the 3D view depends on the speed of your computer as well as the complexity of your scene. Upon

completion, your 3D view should look something like this:

 
This is a painted and a  wireframe of your scene. Your 3D views will default as painted views but
sometimes you may want different types of renderings. 3D EyeWitness will also perform “Wireframe”
and “Hidden- Line” renderings simply by clicking the appropriate icon on the toolbar.

To rotate your 3D view, click any one of the cameras in the upper-left hand corner of the screen.

After viewing your sketch, you’ll want to return to the 2D view. To return to the 2D view, click the Return

to 2D  icon.

Now, let’s view the scene in 3D from the inside. Select Internal View from the 3D menu. Or, click the

3D-Internal View  icon.

A camera outline appears with your cursor, with its field of view in dicated. Rotate the camera using the “+”

and “-” keys on your keyboard. Position the camera so that it is inside the walls of the house in your scene.

Imagine you are inside the building with the camera yourself and are looking for a specific angle from

which to show the scene. Position the camera to look at the table, for instance. When you have the desired

position, click to anchor the camera. 

Note:  To  rotate  the  camera,  or  any  other  symbol,  in increments of 5 degrees, press the
“Shift F3” key on your keyboard, then press the “+” or “-” keys.
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Doubleclick on the camera. Camera Setup window opens. This is where you would change the camera

parameters from the defaults. You can change the height at which the “picture” is taken, as well as other

camera parameters. For the purpose of this tutorial, leave the parameters as they are and click 3D View button.

A message appears indicating that the 3D generation is in progress. Once completed, you will have the

default painted 3D view. This time, from the perspective of the camera that you placed.

As with the external 3D view, you can rotate the camera in the internal 3D view. Click any of the cameras in

the upper-left hand portion of the screen to rotate the 3D view. You can also display a “Wireframe” or

“Hidden-Line” rendering simply by clicking the appropriate icon on the toolbar. After viewing your scene,

return to 2D to make any changes.

4.1.13 Add dimension lines

Most scenes you create will need some type of dimensioning. 3D EyeWitness lets you dimension

automatically or manually. Both options will be out- lined here.

Automatic dimensions are used to dimension walls. Select Dimension Lines from the Draw menu. Drag

your cursor to the right and select Automatic then Overall. Or, click the Dimensioning icon on the top

toolbar, then the second icon down on the secondary toolbar that appears on the left of the drawing screen.

Bring your crosshairs to the drawing area and click once on the wall you want to dimension. A blue line

should appear on this wall. Next, click one endpoint of the dimension line and drag a line parallel to, and

longer than, the wall you just highlighted. Once you have your line longer than the wall, click again to anchor

the second endpoint. The length of the wall will automatically be given as shown below. Repeat this process

for every exterior wall you want to dimension.

Manual dimensions are used to dimension the distance between any two points in your scene. The bottom

three icons on the secondary toolbar are for manual dimensioning. Let’s say we want to find out the

distance between the corpse and the nearest wall. Click the Manual dimension horizontal line icon and

bring your crosshairs to the drawing area. Click on the wall to anchor the first endpoint of the dimension line.

Drag your crosshairs over and click on the corpse. You will then need to position the dimension line by

moving your cursor left or right. When you have the dimension line in the desired position, click to anchor

it. Your scene should then look something like this: (This is a zoomed in view to show detail).

Continue adding dimension lines as needed. You can experiment with the vertical or angled manual
dimension lines by clicking on the appropriate icons on the secondary toolbar.



3D EyeWitness44

DesignSoft

4.1.14 Add text

Like dimensioning, most 3D EyeWitness sketches will need some kind of text to describe the scene in

further detail. To add text, select Text from the Draw menu. A Single Line Text dialog box will appear. Type

in the desired text and click “OK.” The dialog box will disappear. Position your cursor where you want the

text to start and click and hold the mouse button down while dragging to the right to draw a line where the

text will appear. Re- lease the mouse button and the text will appear along the imaginary line that you

draw. The line will not appear.

Add additional text as needed to describe the individual rooms or symbols in the scene. Also, add text to

include the date and address of the scene, or any other pertinent information so that it appears on any

printouts.

Your completed scene should look somewhat similar to the one below. Press the “F2” key to save your
scene automatically.

Congratulations! You  have  just  completed  your  first  scene  using  3D EyeWitness.

Now you’re ready to start your own crime scene or traffic accident scene from scratch. Simply select New
from the File menu and you’re ready to go. You can even start with one of the scene templates included
 in the program as described below.
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4.1.15 QuickHouse

3D EyeWitness also contains a QuickHouse feature with over a dozen house and single room templates.

You simply need to insert the correct wall dimen- sions and 3D EyeWitness will draw the house or room

shell for you. To access these templates, simply click the Wall icon on the top toolbar, then click the House

Type Library icon on the top of the secondary toolbar that appears to the left of the drawing area.

The Select House Type dialog box will open. Simply select the type you desire and enter the new

dimensions and click “OK.” Then anchor the house shell onto the Drawing Area by clicking it into place.

You can quickly and easily create accurate diagrams for crime and accident reports - right from your

laptop or desktop computer.

Easier to draw the floorplan than ever.

3D EyeWitness “House type library” toolbox lets you draw rooms and build- ings fast - all to precise

measurements!

Switch to Wall toolbar/House type library icon! You can pick from pre-drawn building shapes and just
enter in the length of each wall or drag it to a new size. You could also take the easy route of drawing
the wall and modifying it later.





Part

V
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5 Scenes

This chapter outlines the steps for “drawing” building elements in your scene. With 3D EyeWitness,

inserting elements such as doors into a 2D scene is simple. All that’s involved is a couple of clicks on menu

items or icons, followed by a click or two in the drawing area to place and anchor the building element.

Besides  the  insertion  of  building  elements,  another  part  of  creating  a 3D EyeWitness  sketch  is 

modifying  these  elements  -  their  placement,  shape, rotation, height, and so on. You can modify these

elements either before you insert them or later, after they’ve been inserted, as you review your sketch.

Remember that 3D EyeWitness building elements include:

Structural elements such as walls, pillars, windows, and doors. Appliances, furnishings, and
landscaping elements commonly found in and around buildings and houses. Traffic and crime scene
symbols.

You can also draw 2D building elements with the Drawing Tools icon. Such custom symbols act as

placeholders in the scene, reminding you of a specific type of element you plan to include. Because these

custom elements will not appear in 3D, their creation is covered in the next chapter. You will, however, be

able to use the 3D Modeler functionality of 3D EyeWitness to create cus- tom 3D symbols of your own that

 will appear in both 2D and 3D. This creation is covered in a separate chapter later in this manual.

Drawing Tools icon

5.1 Creating Building Elements

Each building element has default parameters. You can alter these parameters by selecting Default Values

from the Options menu or use the   icon and dragging to the right to select either Walls, Slabs, Columns,

or Stairs.

5.1.1 Using the Keyboard to Enter Elements

When you’re experimenting or just sketching scenes quickly, you’ll probably draw elements using the
mouse. There’s nothing as fast and as easy as inserting a set of four walls with a couple of clicks and a slide
of the mouse.

If you’re serious about creating a scene absolutely accurately, though, you’ll need to use a considerably
greater level of care as you draw elements. For this accuracy, turn to the keyboard.

For example, let’s use the keyboard to enter specific coordinates for the endpoints of a wall. Position the
crosshairs where you want the first endpoint to be and hit “Enter.” This locks in the first endpoint. Next,
hit “x” or “y” on the keyboard. The Coordinates dialog box appears, as explained in Chapter 3. Type  13’ in
the “dx” box and hit “Enter.” Now, without moving your mouse, hit “Enter” again to lock in the second
endpoint 13’ away from the first endpoint.

You can experiment by entering different values in either the “dx” or “dy” boxes in the Coordinates dialog
box.

Note: Using negative values in the “dx” or “dy” numbers will draw the wall to the left or down.
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Or, you can use the arrow keys on your keyboard to create walls. Position the crosshairs where you want
the first endpoint to be and hit “Enter.” Hold “Shift” down and press your arrow key in the direction you
want to go. You’ll notice the wall is created in 1’ increments. Release the “Shift” button and you’ll notice
the wall is created in 1” increments when you press the arrow keys. Hit “Enter” when you have the wall
the length you desire.

Note: For creating walls down to the 1/16”, press the “F3” key after anchoring the first endpoint.
“F3” toggles between 1” and 1/16” increments.

The keyboard is also used to control symbol rotation. Pressing the “+” or “-” keys before the symbol has
been anchored into place, rotates the symbol by 45 degrees. 

Note: To rotate symbols in increments of 5 degrees, press the “Shift F3” key before rotating. “Shift
F3” acts as a toggle between 45 degrees and 5 degrees. You can change the angles in the
Options\Rotation settings... dialog bar.

5.1.2 Slabs

If you are either starting a scene or creating a ceiling for a single story building, slabs are the place to be.

Slabs serve as both floors and ceilings. Floors of upper levels are the ceilings of the lower level. If you

did not place a slab between two levels, you would have a cathedral ceiling for the lower level.

Note: Slabs can also be used as shelves, counters, and beams for ceilings. Simply modify the
length, width, and vertical shift as needed.

In the list of steps below, you can modify the slab parameters before you create it. Or, you can just draw the

slab now and modify it later.

1. Select Slab from the Draw menu. Drag the mouse to the right and select Rectangle or Polygon. Or,
click the Slab icon.

Slab icon Current Slab Parameters icon

2. Optional: Modify the slab before you enter it. After clicking the Slab icon, secondary slab icons will

appear on the left of the drawing area. This is the secondary toolbar. To change the slabs parameters,

click the top icon on the secondary toolbar.
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Click this icon to change the thickness, vertical shift, or surface properties of the slab you’re about to draw.

The following dialog box will open.

The dialog box shown is for the Rectangle Slab Settings. To open the Slab Settings dialog box for the

Polygon Slab, click the Polygon Slab icon on the secondary toolbar before clicking the Current Slab

Parameters icon.

Thickness: Change this value to change the thickness of the slab.

x-Width and y-Width:  use your mouse, 

Vertical Shift: Top / Bottom / Arbitrary. Change this parameter if you need to change the distance a

slab will be from the ground. For example, if you have a split - level building in your scene. If not, leave

this value as “0” as the slab will automatically be placed as the floor.

Note: Unless the Vertical Shift is changed, slabs will not automatically  fall  to  be  the  floor of  the
 level  you  are working on.

Visualization: Top/Bottom/Side: This is where you define what surface type you want. Click the

corresponding color tile for “Top / Bottom / Side”. These textures will show in 3D.

Click “OK” when you have made all the changes you desire.

3.   Now, let’s draw the slab. Click in the drawing window to anchor one cor- ner of the slab. Drag the

cursor, or use the arrow keys, to create the size slab you desire and click to anchor the opposite corner.

For a Polygon slab, click to enter the first point and move the cursor to the second corner and click to anchor
it. Continue with as many corners as you need to complete your slab. To close your slab, doubleclick on the
last cornerpoint or click on the first cornerpoint again.
To use the arrow keys to create your slab, hit “Enter” in place of clicking the mouse and press the arrow

key in the direction you wish to create your slab. Hold “Shift” down while pressing the arrow keys to move in

 1’ incre- ments. Release “Shift” to move in 1” increments.

To create a split - level building, use two or more slabs in the same level. Change the Vertical Shift in the

Slab dialog box to control the distance you need that slab shifted. Enter a positive value to shift the slab

up and a negative value to shift the slab down. Or, you can make the higher slab thicker. Connect these

two slabs with a set of stairs.

5.1.3 Walls

Walls are created much the same way, whether they are the external walls of a building or the walls of a room

inside the building.

To create a wall:
1. Select Wall from the Draw menu and drag your mouse to the right to select the style of wall you

want to create. You can draw a single wall, a rectangle of walls, polygon of walls, or curved walls. Or,

click the wall icon, then the corresponding icon from the secondary toolbar that appears on the left.

2. Optional: Modify the wall before you enter it. After selecting the wall style you want, click the

Current Wall Parameters icon on the secondary toolbar to open the Wall Settings dialog box.
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Thickness: Change this value to change the thickness of the wall.

Height: Change this value to change the height of the wall.

Vertical Shift: Change this parameter to change the distance the bottom of the wall is from the floor.

Most of the time you should leave this value as “0”.

Match: With this option checked, drawing a wall endpoint close to an existing wall will cause it to

snap to the existing wall.

Visualization: -Surface Properties: Click on the color tile corresponding to what side you want to add

surface textures. Choose the texture you want from the box that opens and click “OK.” These textures

will show in 3D.

Click “OK” when you have made all the changes you desire.

3. Now, let’s draw the wall(s). Click to anchor the first endpoint of the wall. To  finish  the  wall,  follow 

the  directions  below  for  each  wall  type. A corresponding icon for each type is on the secondary

toolbar.

 Single Wall: Move the mouse to set the wall’s length and click to anchor the second endpoint.

Pressing “Spacebar” before anchoring the second endpoint will flip the wall being drawn to the other

side of your crosshairs. By default, single walls can only be drawn at 90 degree angles. To draw walls at

any other angle, select Ortho from the Options menu.

 Rectangle: Drag and click to anchor the opposite corner of the set of four walls.

 Polygon: Move the mouse to the second endpoint of the first wall segment and click to anchor it.

That second endpoint now serves as the first end- point of the second segment of wall. Move the mouse

to create the second segment and click to anchor the second endpoint of the second segment of wall.

Continue in this fashion. When you have all the desired walls, click the right mouse button to escape.

To draw segments at different angles, select Ortho from the Options menu.

 Curved: Move the mouse away from the first anchored point and click. A “rubber line” is
attached to the anchored points. Move the mouse to make the curve longer and the arc greater or lesser.
Click to anchor the curved wall.

To  create  walls  using  the  keyboard,  follow  the  instructions  earlier  in  this chapter.
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Walls  can  be  modified  in  many  ways.  The  bottom  three  icons  on  the Secondary Wall Toolbar  are 

short  cuts  to  wall  modifications  and will  be explained later in this chapter.

5.1.4 Doors

With doors, you either enter a default door of type 1 (each door in the library has a type ID number), or

choose one from the Door library.

To enter a door, follow these steps:

1. Select Door from the Draw menu or click the Door  icon. The Door library will open.

2. Select the door you want to insert into your scene by clicking on it. Change the height or width of the

door and add a threshold if you want at the bottom of the Door library. Hit “Enter” after you make a

change to the door’s parameters. Click on the wall where you want the door to be. Move the rectangle that

appears with your mouse until you are satisfied with the location of the door and click to anchor it. The

door swing will be in blue. Using the icons on the secondary toolbar, you can change the swing of the

door. Click on any of the icons described below to change the swing or appearance of the door in your

scene while it is blue. Once you have the desired door appearance, click anywhere else in the drawing

area to turn the door swing black.

 Single swing  Sliding doors

 Double doors with unidirectional swing  Overhead or garage door

 Double doors with bidirectional swing  Changes the hinge 

 Folding doors  Modifies the swing

  Reveal  Wall side
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  Reveal  Walls side

 Wall axis  Slot

5.1.5 Windows

With windows, you either enter a default window of type 100 (each window has a type ID number), or you

choose a window from the Window library.

To enter a window, follow these steps:

1. Select Window from the Draw menu or click the Window  icon. The Window library will open.

2. Select the window you want to insert into your scene by clicking on it. Change the width, height, and

sill height as desired and hit “Enter” after you make these changes. Next, click on the wall where you

want the win- dow to be. Move the rectangle that appears until you are satisfied with the location of the

window and click to anchor it.

Note: The Door and Window libraries take up more than one full screen. Use the scroll bars on
the right side of the library to see more choices.

5.1.6 Stairs

Many stair styles are possible with 3D EyeWitness. You can create a straight set of stairs, which is the

default.

Note: The arrow on a set of stairs points to the top of the stairs.

Create stairs in the level from which they originate. To create a straight set of stairs, follow the steps

below. 
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1. Select Stairs from the Draw menu and drag to the right to select Stair case. Or, click the Stairs

 icon.

2. Click the Current Stairs Parameters icon on the secondary toolbar. It is the top icon. This will open the

Stair Settings dialog box.

 
Change these values as needed. When you have made all the necessary changes, click “OK.”

Width: Change this value to change the width of the staircase.
Stairs Riser: Change this value to change the height of each individual stair.
Stairs Tread: Change this value to change the length of each stair.
Stair Number: Enter the number of stairs you need.
Vertical Shift: Change this value to control the stair shift. This value indicates the distance from the
bottom stair to the floor of the current level.
Visualization: Click this color tile to add a surface texture to your set of stairs. Choose the texture
from the window that opens.

Note: Multiply the number of stairs by the stair riser value to calculate the height of the staircase. In
most cases with a straight staircase, this value should equal your wall height.

Again, once all your changes have been made, click “OK.”
3. Click the Stairs icon on the secondary toolbar to select the stairs you just created. Position the staircase

in your drawing area, rotate it as needed by pressing the “+” or “-” keys, then click it into place.

Simple winders can be directly inserted to the floor plan. They can be moved around the floor plan with the
+/- buttons. These winders have the advantage of being introduced swiftly and easily, but have limited
complexity and no internal supporting structure can be constructed for them. Winders can be
interconnected through landings. The vertical position of winders and landings should be adjusted so they
fit together. If the size of a winder is not suitable for your plan, select one of the arrows on the edges of the
winder (which should be already inserted into the plan) and stretch it by keeping the left button of the
mouse pressed down and adjusting its length manually. The winder can be moved by clicking on the arrow-
cross in the center and dragging it. You may introduce any number of winders, specifying the vertical shift
for each.
Rails may also be added to stairs.

You can expand a staircase by clicking on it and stretching it with one of the arrows. 
You can also move around the staircase with the arrow at its center.
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5.1.7 Designing stairs by winders

Designing winders individually: The software also enables you to design stairs individually. 
Designing stairs by designing its constituent winders one-by-one: The stair designer may be opened

by the  icon. In this window you may specify the type of the stairs:
Curved flight. After that, you can set the properties of the winder. This is a multi-window dialog,
therefore you may also adjust a supporting structure, a landing for the winder, or set the number of steps,
the parameters of steps etc.
As you fill in the parameters of the stairs, a sketch of the corresponding structure (from a bird's eye view) is
continuously shown in the graphical window on the right. You may correct and overwrite the values you
previously entered. (The software prompts you on certain errors.)

5.1.8 Rails

Rails can be placed on stairs or anywhere else you might find them. To enter rails, follow the steps below.

1. Select Rail from the Draw menu or click the Rail  icon on the primary toolbar or on the

secondary toolbar of the Stairs.

Rail library

2. Select a rail from the library that opens. You can modify the rail before you enter it by changing the height

and vertical shift in the library window. Hit “Enter” after you make a change.

3. Click on the first endpoint for the rail, which is usually at one end of a set of stairs. A “rubber line”

follows the cursor as you move it to the other endpoint. Click to anchor that second endpoint.



3D EyeWitness56

DesignSoft

By default, you can create another rail. Click the right mouse button (or press “Esc”) to escape the rail

drawing process. The rail will appear as a heavy, colored line and will automatically follow up and down

the stairs.

4. To create rails on a level surface, follow steps 1 and 2 above and click in the drawing area to anchor one

end of the rail. A “rubber line” folows the cursor as you move it to the other endpoint. Click to anchor

 that second endpoint. Then click the right mouse button or press “Esc.”

5.1.9 Columns

Columns can be used to create many different items in 3D EyeWitness. Use Columns if you need beams,

 pillars, footings, etc. To enter a column into your scene, follow the steps below.

1. Select Column from the Draw menu or click on the column  icon. Drag your mouse to the right

 and select one of the three style choices, Rectangle, Circle, or Polygon. Or, click the Column icon.

2. For rectangle and circle columns, a colored outline will appear with your cursor. Click to anchor the

column in your sketch. Enter as many as you like, up to 28. Then, click the right mouse button or press

“Esc” to escape the column creation function.

For a polygonal column, move the cursor to the location of one of the column’s cornerpoints and

click. Continue to mark other cornerpoints by clicking. Close the column by clicking at the original

cornerpoint.

3. To change the default settings for any column style, click the Current Col- umn Parameters icon at the

top of the secondary toolbar before inserting the column. The Column Settings dialog box will open.

The Rectangle Column Settings dialog box is shown here.

      

· Height: Height of the lower and upper plane of the column. In default mode it is equal to the level
height. If the latter is modified, the height of default columns will also change accordingly.

· Vertical shift: Height of the lower plane of the column. 

· Axis slope (X,Y): Assign a different X and/or Y value to the centre of the upper and lower plane,
creating an oblique column.

· X-size (1,2): size along the X axis for the lower and upper plane.

· Y-size (1,2): size along the Y axis for the lower and upper plane.

· Ground plane angle: ground plane angle of the column. You can rotate the column by the + and –
icons.
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· Cut by roof: The column cannot go higher than the roof’s plane, and will be cut by the roof.
Visualization: Surface Properties: Click the color tile to choose a surface texture for your
column. Any change made here will apear in 3D renderings.

When all the necessary changes have been made, click “OK,” then follow step 2 above.

5.1.10 Symbols

Symbols in 3D EyeWitness are grouped into nine different libraries. You can also create your own 3D

symbols and custom libraries using the 3D Modeler. Instructions on creating your own 3D symbols are in

Chapter 8.

To insert a symbol into your sketch, follow these steps:

1. Select Symbol from the Draw menu and drag your mouse to the right to select one of the symbol

libraries. Or, click the Symbol icon on the primary toolbar. The secondary toolbar will appear to the left

of the drawing area. Click any of these icons to open the corresponding symbol library.

2. The symbol library you chose opens in the Symbol Library dialog box, one example is shown here.

Simply scroll through the library to find the sym- bol you want and click on it.

 
3. Optional: Modify the symbol before you enter it. In the dialog box, you can change the symbol’s

size, color (surface), and shift.
x-size, y-size, z-size: The x size is the symbol’s width. The y size is the symbol’s length. The z

size is the symbol’s height. Change these values as needed.

Shift: This is the distance the symbol will be placed off the floor. For example, to place

kitchen cabinets halfway up a wall, you should change this value.

Also, be sure to change this value if you are placing one symbol on top of another. For example, to

place a knife on a table, notice the height of the table when you place it. Then set the vertical shift value

for the knife to be the height (z-size) of the table.

 : Click here to change the color or surface texture of the symbol.

4. Reselect the symbol once all the desired changes have been made. You’ll have  a  colored  outline  of 

the  symbol  follow  your  cursor.  Position  the outline  where  you  want  the  symbol  to  be  in  your 

scene.  Rotate  it  by pressing the “+” or “-” keys on your keyboard. Click to anchor the symbol.

The colored outline will stay with the cursor after you place the symbol. Click the right mouse button

to get rid of this outline, or click the left mouse button to place this same symbol again.
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5. Optional: Select a different symbol from the same library or change libraries by clicking the down arrow

next to the library name at the top of the Symbol Library dialog box.

5.1.11 Roofs, Chimneys, Skylights, and Dormers

3D EyeWitness contains a number of pre-defined roofs for the buildings in your scenes. You insert

roofs into your sketch much the same way as you insert other symbols. 

To insert a Roof, follow these steps:

 

1. If necesary, open the top level of your scene. The roof will automatically snap to the top of the current
level.

2. Select Roof from the Draw menu and click on Roof from the menu that opens when you drag your
mouse to the right. Or, click the Roof icon on the primary toolbar then click the topn icon on the
secondary toolbar that appears to the left of the drawing area. This will open the Roof Library dialog
box.

3. Select the roof style you want from the library.
4. Optional: Modify the roof before you enter it. In the dialog box, you can change the roof’s length,

width, pitch, and surface properties.
x-size, y-size, z-size: The x size is the roof’s width. The y size is the roof’s length, and the z size is

the roof’s height. Change these values to change the size of the roof.

Note: Changing the z size of a roof symbol changes the pitch of the roof.

Shift: Roofs will automatically snap to the top of the level you are on. Change this value only if

you want a non-standard placement of the roof.

Surface: Click here to change the color or surface texture of the roof.
5. Once all the desired changes have been made, position the roof in the scene and click to anchor it.

Remember, you can rotate the roof like any other symbol. The colored outline will remain until you

click the right mouse button or press “Esc.”

Note: Roofs are automatically sized to fit the main build- ing in your scene. Change the x, y, and
z, values as needed before placing any non-standard roof.

To insert a Chimney, follow these steps after you have inserted a roof.
1. Click the Chimney Library icon on the secondary toolbar after clicking the Roof icon.
2. Select the chimney style you want from the library box that opens.
3. Position the chimney in your scene and click to anchor it. Click your right mouse button to eliminate

the colored outline that moves with your cursor.
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Note: Unless the Shift value is changed, chimneys, sky- lights, and dormers will automatically
snap to the top of the roof.

4. Optional: Modify the chimney before you enter it.
x-size, y-size, z-size: Change these values to change the length, width, and height of the chimney just

like you would any other symbol.

Shift: Change this value if you do not want your chimney to snap to the top of the roof. This is the

distance the chimney will be off the floor.

: Click here to change the color or surface texture of the chimney. 

To insert a Skylight, follow these steps after you have inserted a roof.

1. Click the Skylight Library icon on the secondary toolbar after clicking the Roof icon on the primary
toolbar.

2. Select the skylight you want from the library by clicking on it.
3. Position the skylight where you need it in your scene and click to anchor it. Rotate the skylight with your

“+” or “-” keys before anchoring it. Click the right mouse button to escape the skylight creation process

when you have entered all the skylights you need.

4. Optional: Modify the skylight before you insert it.

To insert a Dormer, follow these steps after you have inserted a roof.
1. Click the Dormer Library icon on the secondary toolbar after clicking the Roof icon on the primary

toolbar.
2. Select the dormer you want from the library by clicking on it.
3. Position the dormer where you need it in your scene and click to anchor it. Rotate the dormer with your

“+” or “-” keys before anchoring it. Click the right mouse button to escape the dormer creation process

when you have entered all the dormers you need.

4. Optional: Modify the dormer before you insert it.

5.1.11.1 Automatic roof designer

After clicking on the icon, you should draw the polygonal structure of the roof. In the right click menu you
may decide whether you want to draw the shape of the roof or you want to have it automatically generated
(along the external edges of the building) by providing a reference point. 

You may also switch on the feature Room or building shaped , with this feature activated you
need only to click on an outer wall of a building, and the room is automatically created along the walls. 

Switching on  the feature Use corner points of the supporting structure entails a shape along the
wall structure, without taking into account the thickness of the wall's layers. 
If you switch off Room or building shaped you shall have to draw the shape of the roof yourself. When
drawing the roof you are helped by the appearing black pipes (if Snapping is turned on). 
After having designed the polygonal shape of the roof  the Automatic roof designer window appears.
Here you can set the roof pitch, choose from different kinds of roofs (normal, hip roof, with gable). The
roof pitch is the same all along the roof. However, along the edges of the roof, other parts of a different
orientation can be attached by the Automatic roof designer.
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5.1.11.1.1  Designer window

 Cm/Inch icon: select a unit of measurement

 Clicking this icon erases the values (of the roof pitch) entered into the fields 1,2,3 

 Visualize the roof in 3D mode

 By clicking on this icon, you may set the other properties of the roof

 Set the properties of the valley, the ridge and the eaves

 Visualize the roof in 3D mode with colors and paintings

 Remove the roof and return to the 2D designer

 Transfer the roof to the plan and return to 2D mode

 Help
1,2,3: the values of the roof pitch (steepness) may be entered by filling in the fields dx, dy or by specifying
the angle and then hit Enter. After entering two values the third is automatically calculated by the software.
dx or dy: If there is a break (fracture?) in the roof pitch, then you may set the position by dx and dy, dx
determining its position from top view and dy  its height.
Width of the eaves: Set the width of the eaves. This entails the expansion of the roof's contour by the
submitted value and the rearrangement of its overall structure.
Elevation height of hip roofs: Here you may set the height where the tetokonty starts from. You may
enter a negative value as well, this creates a roof plane reaching down.
Mouse function: 
Normal roof/Hip roofs/Set gable wall: After selecting the roof type, click on an edge of the wall, and the
roof will be reconfigured accordingly, which is displayed in the visual field.
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5.1.11.1.2  Specifying the roof's thickness and height

 

With the double click on the roof a dialog box is brought up wherein you may set further properties of the
roof:
Changing the roof's thickness (for 3D mode): The roof covering has no thickness in default mode. Here
you may assign a thickness to it in different ways, shown on the drawings on the right.
None: no thickness assigned.
Vertical: The roof covering gains a vertical thickness of the entered value, as shown on the drawing.
Perpendicular, with horizontal eaves: As above, the roof covering gains a vertical thickness of the
entered value, but the lower plane of the roofing has a horizontal orientation.
Perpendicular, with vertical eaves: the roof covering gains a vertical thickness of the entered value, the
lower plane of the roofing having a vertical orientation.
Perpendicular, with cut (two-way) eaves: the roof covering gains a vertical thickness of the entered
value, the lower plane of the roofing having a vertical and a horizontal part.
Thickness (a) : This is where you may set the value of thickness for the roofing.
Roof vertical shift: Here you may give the vertical height of the roof's lowest point (?) relative to the level
height.

5.2 Creating Multiple Stories

The terms “story,” “level,” and “floor” are synonymous in 3D EyeWitness. To create a scene that has has

more than one story, or level, you open more than one window in a project, one for each story. This is a

simple procedure thanks to the exclusive Level Manager in 3D EyeWitness.

To open up the Level Manager, select +  or  Level from the View menu. The following

window will open. A small example scene is shown in the window.
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Add level: Click on this button to add a new floor, or story, to a scene. Choose whether you want to

copy the current level or leave it empty and where you want the new level to be. Click “OK” to add

the new level. A new level tab for the new level will appear at the bottom of the dialog box and at the

bottom of the Drawing Area.

Remove level: Click on this button to delete the current level. 
Height: This is the height of the current level, or story. The default value here is the default height of
a wall. Change this value to the height of the tallest wall in the story if you have changed any of the
wall heights.
Name: You can name each individual level in 3D EyeWitness. Changing the name here will change
the name of the level on the level tab at the bottom of the dialog box.

Note: To switch levels in a multi-level scene, click on the desired level tab at the bottom of the Drawing
Area.

5.2.1 Using Layering to Align Levels

As you begin to work with a new story, or level, in a building, one of your first questions will be, “How do
I align a new level with the one above or below?” Such alignment is easy with the layering capability of 3D
EyeWitness.

Make the new level the current one by clicking it’s level tab at the bottom of the drawing area. Next, select

 Level Foils from the View menu. Select the level you wish to view by clicking it, then click “Close.”
All the walls in that level will appear in color on the current level. You can now create your walls by
tracing them over the colored ones of the other level to ensure that your levels align themselves properly.

Levels foils 
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5.3 Modifying Building Elements

Common Windows editing commands are available in 3D EyeWitness. Two common  editing 

procedures  -  select  and  move  -  are  desrcibed  here.  In addition, specific information about each

building element is provided in this section.

Select:  The  first  step  in  modifying  elements  is  to  select  an  element  or elements. Generally, when

a building element is selected, it changes color. (A colored line appears inside walls to show that they

are selected.)

Select an object by clicking the Selection Tool icon, then by clicking on that element. You can select a

group of elements by drawing a box around the group of elements desired. Or, choose Select All from the

Edit menu to select all the elements in the scene.

Note: To select an element that is on top of another element, click the Selection Tool icon
and click on the element. Then, press the Spacebar. Pressing Spacebar toggles between
over- lapping elements.

Selection Tool icon
As you perform an operation, a colored outline of the symbol (or a line, in the case of a wall) indicates

the effect of this operation. In other words, if you select a wall and move one end of it by dragging the

cursor, a colored line representing the wall moves with the cursor. Only when you click to anchor the new

position of the wall’s endpoint does the wall itself move.

Move: Once you have selected an element, the easiest way to move it to a new location is by dragging

that element. Click and hold the mouse button down while dragging the element. Once you have the

element in the new desired location, release the mouse button. If, while dragging, you cannot drag at

an angle, select Ortho from the Options menu.

You can also move objects using the  button. When the objects are selected press the  button and

use the cursor arrow keys to move them in 1” or 1cm steps. Hold down the shift key to move the objects in

1’ or 1m steps.

5.3.1 Slabs

You can modify a slab in the following ways:
1.   Move it: Select the slab, place the cursor anywhere on the slab, and drag it to the new location.

2.   Change its parameters: Double-click on the selected slab to open the Slab Setting dialog box. Make the necessary
changes and click “OK.”

5.3.2 Walls

You can modify a wall or set of walls in the following ways:
1.   Move it: Select the wall. If you click and drag in the middle of a single wall, the entire wall moves. If you click and

drag on one end of a free- standing wall, only that end moves and the other end stays anchored. The cursor will become

a circle when you can modify this way.

2.   Change the shape: Select a wall, click on one of its endpoints or on a cornerpoint where walls join, and drag the

endpoint or cornerpoint to a new location. You can turn a rectangular set of walls into a polygon in this fashion.

3.   Change its parameters: Double-click on a selected wall to open the Wall Settings dialog box. Make the desired changes
and click “OK.”

4.   Adjust a wall junction: Select Edit Wall from the Edit menu and click Adjust Wall Junction in the pop-up menu. Or,

click the Wall icon, then the icon on the secondary toolbar that controls this feature. Then, click on the intersection of the

two walls that are not matched. The walls are auto- matically redrawn as a single building element.
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5.   Cut a wall: Select Edit Wall from the Edit menu and click Cut Wall in the pop-up menu. Or, click the Wall icon, then

the icon on the secondary toolbar that controls this feature.

Click at the point in the wall where you want one edge of the cut. Move the cursor to the other end of the cut and click. The

wall will be redrawn with the cut shown. Make sure you are at least 6 inches from a wall joint and that you are positioning

your crosshairs on the wall.

6.   Turn a line into a wall: Click on the Wall icon to open the secondary wall toolbar. Select the line and then click on the

Build Walls From Lines or Curves icon on the secondary toolbar.

5.3.3 Doors

You can modify a door in the following ways:
1.   Move it: Select a door, click on it and drag it to a new location on the same wall.

2.   Change its parameters or type: Double-click on a selected door to open the Door library. Choose a new door style or

change its height and width. Press “Enter” after you make your changes.

3.   Change the swing: Select a door. Then, while it is selected, click one of the bottom two icons on the secondary toolbar to

change its swing.

4.   Add or delete a threshold: Double-click on a selected door to open the Door library. Click on the Threshold checkbox to

 add or delete a threshold in that doorway.

5.3.4 Windows

You can modify a window in the following ways:
1.   Move it: Select a window, click on it and drag it to a new location on the same wall.

2.   Change its parameters or type: Double-click on a selected window to open the Window library. Choose a new window

style or change its width, height, or sill height. Press “Enter” after you make your changes.

5.3.5 Stairs

You can modify a set of stairs in the following ways. Be sure to double-check any changes you make. You could

inadvertantly make changes that result in the stairs either exceeding or failing to reach the next level. Also, note that

when you select a set of stairs, it is marked by handles as well as a colored outline.

1.   Move it: Select the set of stairs, click on it, and drag the stairs to the new location.

2.   Change its parameters: You can change the size of a staircase by drag- ging the handles of a selected staircase. Or,

double-click on the selected set of stairs. Change the parameters as needed in the Stairs Setting dialog box that opens.

3.   Add rails: For instructions on creating rails, refer to the section on Rails earlier in this chapter.
4.   Connect flights of stairs with a landing: To insert a landing in a set of stairs, you need to think of the sets of stairs on

either side of the landing as separate segments.

Create a new set of stairs as described earlier in this chapter. Click on the Landing icon on the secondary toolbar. A

colored outline of the landing will appear. Position this landing at the top of the stairs. Click to anchor it.

Insert another segment of stairs. The Vertical Shift value for this set should equal the height of the first set of stairs plus the

landing. The bottom of this set should be attached to the landing.

You can create different stair shapes by putting together different shaped landings and stair segments of various lengths. 

5.3.6 Rails

You can modify a rail in the following ways:
1.   Move it: Select the rail, click on it, and drag it to a new location.

2.   Change its length with the mouse: Click on one end of the rail and drag the cursor to lengthen or shorten it.

3.   Change its parameters: Double-click on a selected rail to open the Rail library. Press “Enter” after making the necessary

changes.
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5.3.7 Symbols

You can modify a symbol in the following ways:
1.   Move it: Select the symbol, click on it, and drag it to a new location.

2.   Change its parameters: Double-click a selected symbol to open the Sym- bol library. Change its parameters as needed and

press “Enter” after you’ve made all the necessary changes.

3.   Turn it into a different symbol: Double-click a selected symbol to open the symbol library. Select a new symbol from the

library.

5.3.8 Roofs

You can modify a roof in the following ways:
1.   Move it: Select the roof, click on it, and drag it to a new location.

2.   Change its parameters: Double-click a selected roof to open the Roof library. Press “Enter” after making the

necessary changes.

3.   Add elements: To add skylights, dormers, or chimneys, see the Roof sec- tion earlier in this chapter.

5.3.9 Columns

You can modify a column in the following ways:
1.   Move it: Select the column, click on it, and drag it to a new location.

2.   Change  its  parameters:  Double-click  a  selected  column  to  open  the Column  Settings  dialog  box.  Press  “Enter” 

after  making  the  necessary changes.

3.   Change shapes: The best way to change the shape of a column is to delete the current one and create a new column of the

desired shape.

Note: To rotate a symbol, roof, column, or set of stairs after  they  have  been  anchored;  Select 
the  desired element and press the “+” or “-” keys while holding the mouse button down.
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6 Enhancements

This chapter describes various ways of enhancing your 3D EyeWitness sketch. For example, you can draw
“primatives” to describe search areas, or, insert dimension lines to note distances. Text can also be added
to put notes right on the sketch. Lastly, this chapter will describe the automatic Scene Inventory.

6.1 Drawing Primatives

 Primatives are used for many reasons in 3D EyeWitness. You can draw a circle to highlight a search
area, draw a line to point out important evidence, or add text to make the scene easier to understand.

Note:  Primatives  will  not  be  viewable  in  3D.  To  draw custom  symbols  that  will  be  viewed
 in  3D,  use  the  3D Modeler as described later in this manual.

To draw a primative, click the Drawing Tools icon. The secondary toolbar will open which allows you to

choose what style primative you want to draw. The steps involved in drawing each primative are outlined

below.

 Draw a line: In the drawing window, click to anchor one endpoint and move the cursor to where

you want the line to end. Click to anchor the second end- point.

 Draw a polyline: Click to anchor the endpoint of the first segment, move the cursor and click

again to anchor the second endpoint. Move the cursor in a new direction and click to anchor the next

endpoint. Continue as long as you need to. Click the right mouse button to escape this drawing process.

 Draw a rectangle: Click to anchor one cornerpoint. Move the cursor to the opposite
cornerpoint and click to anchor that corner.

 Draw freehand:

 Draw a circle based on center and radius: Click to anchor the center of the circle. Move the

cursor away from the center point and click to anchor the circle.

 Draw a circle based on 3 points: Click to select the first point, and again to select the second.

Move the cursor and define the size of your circle by click- ing in the third point.

 Draw an arc based on center, radius, and angle: Click to anchor the center of the circle. Now,

click on a point along the circumference. This point will serve as the endpoint for the arc. Then, move

the cursor up or down to draw the arc. Click when you have the length arc you desire.

 Draw an arc based on 3 points: The arc is defined by three anchored points. Click to anchor all

three points.

 Draw arrows: Click to anchor one endpoint and move the cursor to where you want the arrow to

end. Click to anchor the second end- point.
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 Text: Click the Insert Text icon. A Single Line Text dialog box appears.In the text field, enter the
word(s) you want to add to your sketch. Change the default height of the text if you desire. Click “OK”
when finished. Click the point at which you want the text phrase to begin.  Click again to insert the
text. If your text is in the wrong place, select it and drag it to the new location. A colored box will
surround the text when it is selected.

 BMP/WMF object: Select BMP, JPG, ICO, EMF, WMF file and define the parameter of the
picture.  Click the point at which you want the picture. 

 Draw rescue route  (in 3D too)

 Draw a line: In the drawing window, click to anchor one endpoint and move the cursor to where
you want the line to end. Click to anchor the second end- point.

 Draw a polyline: Click to anchor the endpoint of the first segment, move the cursor and click
again to anchor the second endpoint. Move the cursor in a new direction and click to anchor the next
endpoint. Continue as long as you need to. Click the right mouse button to escape this drawing process.

 Create legend, Route Table

Explosion and Noise Protection Area: Introduce colored areas to the project with the
option Fill in. Colored area can be hatched as well. 
Set the hatching pattern, background color and color of the hatching lines in the dialog boxes.  The
following types of areas can be filled in: areas encircled by walls, and polygonal or circular areas
defined by boundaries. 

BMP, WMF libraries: You can import BMP,WMF files directly from libraries into your project.
These libraries can be found among libraries of different symbols. 

Proportional resizing: When one of an element's properties is altered, the program automatically
resizes the element to maintain its original proportions.

Show description: The information assigned to an element when it is added to a library is displayed
next to it on the floor plan. 

6.2 Drawing Dimension Lines

 Dimension lines are used to show distances between identified points in your scene. 3D EyeWitness
gives you many options for dimension lines. You can place them inside or outside a scene, you can choose
from a variety of styles, and you can have them drawn manually or automatically.
To draw a dimension line, select Dimension Line from the Draw menu. Then, select Automatic or Manual.
If you select Automatic, the dimension line will change automatically if you later change the length of a
wall.

There are three options each for Automatic or Manual. They are accessed by clicking the pop-up menu that
appears. They are also accessable by clicking the corresponding icon on the secondary toolbar after clicking

the Dimensioning  icon.

Each of the 9 options are described below.

 Overall automatic: Use this option to measure walls. Select the wall you want to dimension. Click
to anchor one endpoint of the dimension line and move the cursor to draw a line parallel to, and at least as
long as, the wall you selected. Click to anchor the second endpoint. The dimension line will appear.
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   Detailed automatic: This option provides a detailed measurement of a wall, broken among
endpoints, windows, and doors. Select the wall and follow the directions for Overall automatic.

 Internal automatic: Use this option to make internal measurements such as the width of a wall or
the internal dimension of a room. Click the endpoints of the line across the space you want to measure. The
dimension line will appear.

 Automatic dimensioning: the program generates 3-3-3-3 dimension lines around the building

 Horizontal manual: Use this option to draw a horizontal dimension line. Click one endpoint of the
line, move the cursor to draw a line horizontally and click
to anchor the second endpoint. Move the cursor up or down and click to posi- tion the dimension line. The
dimension line will appear.

 Vertical manual: Use this option to draw a vertical dimension line. Click to anchor one endpoint of
the line, move the cursor to draw a line vertically and click to anchor the second endpoint. Move the cursor
left or right and click to position the dimension line. The dimension line will appear.

 Angled manual: Use this option to draw an angled dimension line. Click to anchor one endpoint of
the line, move the cursor to draw a line and click to anchor the second endpoint. Move the cursor left or
right and click to position the dimension line. The dimension line will appear.

 Measure area

Note:  Use  the  Manual  dimension  lines  to  dimension anything other than the length of a wall. For
wall lengths, use the Automatic dimension lines.

6.3 Modifying Dimension Lines

You can modify dimension lines in the following ways:
1.   Move it: For automatic lines only, click and drag a selected dimension line to to a new location. You
will not change the measurement itself.
2.   Change its length: For automatic lines only, increase or decrease the length of a dimensioned wall.
The dimension line adjusts to these changes.
3.   Changes its parameters: You can also make other changes to all the new dimension lines you will
draw. Select Dimension Settings from the Op- tions menu. The Dimension Line dialog box will appear.
Each option is described below.
Style: Select one choice from this list to represent the tick marks on the dimension lines.
Text Position: Select one option from each group to represent where text will appear in relation to the
line.
Automatic Dimensioning: Select the point on the doors and windows that is to be used to measure the
distances between wall endpoints, doors, and windows. This option applies to Detailed lines only.
Distance: Specifies the distance between the text and the dimension line.
Text Height: Specifies the height of the text.

Click “OK” after you have made all the desired changes. These changes will not be saved when you exit
3D EyeWitness.

6.4 Using Grids

3D EyeWitness uses a snap-to grid system in the drawing window to increase the speed with which scenes
are drawn and improve the accuracy with which scene elements are placed. Elements can be snapped to a
close gridpoint. To disable snap, select Snap from the Options menu and click “Enable snap” in the Snap
Settings dialog box so the check mark dissappears.You can also change the distance with which scene
elements will be snapped to a close gridpoint by increasing the number of Pixels. Select Change Grid from
the Options menu to open the Grid dialog box.
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Here is where you change the size of the grid or determine whether you want the grid to be visible in the
level you’re working on, or on all levels. You can also toggle between a visible and nonvisible grid by
selecting Grid from the View menu.

6.5 Changing Units

3D EyeWitness also lets you create your scene using Metric measurements. To change to the Metric

system, select Change Unit from the Options menu or  icon. These changes will be saved when you
exit 3D EyeWitness.

6.6 Measuring Areas

To measure an area in 3D EyeWitness, select Measure Area from the Draw menu.
The cursor will become a set of crosshairs in the drawing area. Click to anchor one corner of the area to be
measured. Now, as you move the crosshairs, a “rubber line” is attached. Click to anchor the next corner of
the area. Continue until you are back to the original corner. If you can only draw the lines at 90 degree
angles, select Ortho from the Options menu.
Once you close the area, the Single Line Text dialog box will appear with the size of the area you have
defined already entered. Click “OK.”
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Insert the area size label the same way you would ordinary text. Click where you want the text to begin,
drag a line where the text will be inserted and click to anchor the second point. The size of the area will
appear.

6.7 Scene Inventory

3D EyeWitness automatically generates a catolog of everything you place in your scene. To open up the
Scene Inventory for the scene you are currently working on, select Scene Inventory from the File menu.
Below is an example of an automatic scene inventory.

The Scene Inventory is in spreadsheet format compiled from the scene. To change text in a cell, click on
the cell, enter the information you need and press “Enter.” Under File and Options, you’ll notice that this
inventory can be saved, printed, and modified much the same way as other spreadsheet applications.
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7 Views

Your 3D EyeWitness scene is created in the 2-dimensional view. There are several commands in this 2D
view that can help you draw and modify your scene. For example, you can zoom in on part of the sketch, or
use the layering command.

Part of the usefullness of 3D EyeWitness is in its 3D viewing capability. Your 2D scenes are transformed
to 3D renderings with a couple of clicks of the mouse. Use these 3D views to help you visualize and
examine your scene. For example, you can create a 3D movie, to simulate taking a video recording around
the inside our outside of your scenes. You will even be able to save and replay this movie over and over.

7.1 Viewing in 2D

To change the 2D view of your scene, select a command from the View menu. Each command is described below:

7.1.1 Zoom

Zoom In -- Ctrl+Num+ : Increases the appearance of the scene.
Zoom Out  -- Ctrl+Num+ : Decreases the appearance of the scene.

 Zoom Window -- Ctrl+W: Lets you select the portion of the scene for which you want to
increase the appearance. Drag a box around the area of the scene you want to zoom into.
When you click to enter the second cornerpoint, you will automatically be zoomed in on the
boxed in area. This option is also accessible by clicking the Zoom Window icon.

 Zoom to Extents -- Ctrl+E: Increases or decreases the appearance of the scene, to the
extents of your sketch, by placing the whole sketch in the drawing area.

 Last Zoom -- Ctrl+L: Redisplays the last view of your scene.
Default Zoom -- Ctrl+D : Redisplays the original view of the scene.

 Set Zoom Window: Lets you specify a zoom view to redisplay. The Zoom Window
Setup dialog box will appear. Change the specified values to change the size of the viewable
screen. Click “OK” after making the changes.

 Air View -- Ctrl+Z: Displays the entire plan in the Air View dialog box. The colored
outline will designate the drawing area. Drag the colored outline to change the display in the
drawing area. This option is also accessible by clicking the Air View icon.

 Redraw --F6:  Redisplays  your  current  view.  Select  this  option  periodically  to
“refresh” your drawing area, especially after making some modifications to your sketch. This
option is also accessible by clicking the Redraw icon or by pressing F6.

7.1.2 Layering

The dialog allows you to choose those elements in your design which you want to view. Think
of each set of elements as residing on a layer. For example, the layers might be doors,
symbols, roofs, slabs, etc. You use the Layering command to view or hide the elements you
choose. The building, drawing and other elements can be placed on different layers. You can
display or hide layers and also lock or unlock the elements on a layer. If a layer is locked, the
elements on the layer cannot be moved.

The element being drawn will be placed in the layer previously selected. This is shown in the

Layers window. You can display this window by pressing the  Layers button at the bottom
of the screen. You can move selected compo- nents from one layer to another by pressing the
right mouse button and select- ing the Change visibility command.
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You can set the visibility and other properties of the layers in the Layer and Layer settings
windows using the icons described below.

  2D/3D/Print Switch On/Off the elements visible

 Open lock permits the elements in the layer to be moved
 Closed lock prevents the elements in the layer from being moved

The default layers are shown with a blue background. These layers are permanent and cannot
be deleted or renamed. The layers shown with a gray background are user defined and can
be renamed or deleted. In a layer you can hide and lock element groups by their function for
example all the walls etc.
This function allows you to choose which elements in your design you want to view. Think of
each set of elements as a layer. For example, doors, symbols, roofs, slabs, etc. You use the
Layering command to view or hide the elements you choose.

Level Foils dialog
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8 Viewing in 3D

2D-3D parallel editing makes it possible to edit your project in one window while following changes in the
other as well. In this mode changes done to your plan in the 2D window automatically appear in the 3D
window and vice versa. It is thus possible to make changes to your plan in 3D mode as well. The following
icons are there to help you do this:

8.1 Displaying a 3D External View

3D EyeWitness gives you several viewing options when you create an external view of a scene. You can

decide to display the entire scene, or one level at a time, and you can rotate the view to see it from any

angle.

Note: By “external,” we mean you will get a 3D view from a predetermined perspective. To choose
your own perspective, see the section on 3D Internal View.

To display a 3D External View, follow these steps:

1. Create your scene in 2D.

2. Optional: Select 3D Parameters from the 3D menu. The 3D Parameters dialog box will appear. An

example, and description of, this dialog box is shown on the next page.

 

Technology: OpenGL / DirectX
Hardware / Reduced mode
Rendering mode: Wireframe / Hidden / Painted drawing

You can select Wireframe / Painted drawing / Hidden mode. 

Level Up: Enter the number of the top level to appear in the 3D view.
Level Down: Enter the number of the bottom level to appear in the 3D view.

Lighting: None / Just in Paytrace / Anywhere
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Click “OK” when you have entered the desired settings.

3. Select  External View from the 3D menu. Or, click the 3D External View icon. A message will

appear indicating that the 3D view is being generated.

  

8.2 3D visualisation

3D visualization of the project: from the outside and inside. The project can be visualized in 3 dimensions
at any point. The most basic 3D view is the 3D image of the entire building from the outside. This is

created by simply clicking on the  icon. The inside view is created by first clicking on the  icon,
and then putting down the camera, doubleclick on the camera and select the 3D view. 

Camera direction: Orientation of the camera on the floor plan, defined in degrees. 

Vertical angle: Vertical angle of the camera. A horizontal orientation is defined as 0 degrees; negative
values indicate downward-tilting cameras. 

Aperture angle: Aperture of the camera in degrees.

Height: Height of the camera, relative to its level.

The 3D window has a different set of (upper row) icons, the wireframe or painted image of the project can
be seen below. You may change between the wireframe and colored representations in the 3D/3D

parameters menu of the 2D editing window or by the   icons of the 3D window. The
icons of the 3D window may be removed (and put back) by right clicking on the icon bar and choosing

between the icons or by the menu opening up after clicking on the  icon.  The items marked with a
small pipe are displayed in the icon row.
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The icons (Alt 1 or Alt 2) enable you to choose between the external: Examine Alt+1 and the
camera Handycam Alt+2 views, while also determining which set of icons are displayed by switching on
the Navigation  menu:

the rotating-moving arrow icons:   

the camera adjustment icons:  They can also be
moved (rotate) with the mouse.
The 3D picture can be rotated or moved around by these icons, or by the mouse, including its scroll-
wheel. The adjustment of 3D parameters can be done (partly) in the 3D/3D parameters menu of the 2D

editing window.Other parameters can be adjusted by clicking on the  icon of the 3D   window.  For
example, you may set the optical parameters of painted images, the line colors for wireframe pictures here.
The dialog has multiple sub-windows.  Changing between the colored and hidden line views is possible in

Rendering mode or by the  or   icons. 

By  the icons you can change between the perspective and frontal views, these icons
are switched on by clicking on Projection modes in the right click menu.  You may resume to 2D editing by

clicking on the icon.

 



Viewing in 3D 81

DesignSoft

Painted mode  Hidden line mode

Rotate: Once you have your 3D rendering, you may need to rotate it to view it from a different perspective.
To do this, simply click on one of the arrows in the upper left-hand corner of the screen. They can also be
moved with the mouse.

 

 Wire Frame: Click this icon to generate a see-through wireframe 3D view.

 Hidden Line Elimination: Click this icon to obtain a solid line drawing of your 3D view.

 Paint: Click this icon to return to the painted view of your scene in 3D.

 Ray Trace: Create Photorealistic

  Return to 2D: Click this icon to return to the 2D drawing of your scene.

 Export to 2D: Click this icon to export the hidden lines to 2D drawing editor

8.3 Changing colors/textures in the 3D window

It is possible to change colors or textures on the 3D painted image without returning to 2D mode. In the 3D

window you may switch into selection mode by the   icon. Textures can then be selected simply by
clicking on them. Alternatively, you may select textures by moving the mouse above, right-click and select
Change color/texture. The software automatically identifies the texture and locates it in the relevant
group of textures, thereby facilitating the choice of the new texture to be inserted. However, you may
access another group of textures and select a different one to be inserted. After clicking OK, the software
automatically replaces all items of the selected texture. 
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You may save the textures used in a particular plan as a group of textures to be used later on with the 
icon. 

These saved groups of textures can then be loaded by clicking on the small arrow next to the icon and
selecting the given group. When loading one of these groups, you may choose to add them to the textures
and colors already present in the ongoing project. This can be done by clicking on Yes, when the question
Continue from current surface changes (yes)\or apply changes from the default state (no)? comes
up.

Note: When selecting the surface/texture to be replaced or modified, note that in the yellow-
colored information bar at the bottom of the screen you can see which item will be selected (if
right-clicking).

8.4 Editing in 3D, following in 2D

2D-3D parallel editing makes it possible to edit your project in one window while following changes in the
other as well. In this mode changes done to your plan in the 2D window automatically appear in the 3D
window and vice versa. It is thus possible to make changes to your plan in 3D mode as well. Tthe
following icons are there to help you do this:

 

·   Ortho (Ctrl+O): Use this icon to move objects. The x and y axes appear and you can move

objects along these two only. It is possible to rotate the coordinate system by the  icon, redefining

the orthogonal axis. With the  icon the axes of the ccordinate system become visible in 3D.

·   F3: assign a minimal step for rotating and shifting objects (1 cm/m (or inch) feet for moving
objects, 45 or 1 degree for rotating). You can adjust these values in Settings/Editing.
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·    F4: Coordinate system visibility.

·  Reorienting the coordinate system: Redefine the default orientation of the coordinate system in 
3D.

·   Keep ratio: switch this option on and manual resizing will be done by keeping the proprtions of
obejcts unchanged.

·   Change colors, patterns in 3D.

·   Save current colors and patterns.

·   Remove objects.

8.4.1 Selecting and modifying elements in 3D

It is now possible to edit your project in 3D Paint Mode  as well. All changes made to your plan
are automatically applied in 2D as well. Move the mouse over an element and its properties can be seen in
the info-line at the bottom of the screen. When a small pipe appears next to the cursor the element can be
changed and edited. Click on the object to start editing it. You can select multiple elements by holding
down Shift and selecting them. Select all elements by hitting Ctrl+A.
When an object is selected in 3D, a red selection frames appears around it and red points show the
element's hot spots. Amongst these are the points of reference for moving or rotating the object.

Some elements cannot be moved, these ones do not have a point of reference for moving them, logically.  
You can rotate some elements (for example symbols) by moving the mouse over the selection frame and

rotating the object along its axis. The    icon should appear.
You can see the properties of elements in the information line at the bottom of the screen.

8.4.2 Data entry mode

  Data entry mode:

· When moving an element you can see the scale of the shifting in the x, y and z direction in the first 3
fields of the info-line.

When rotating an element, you can see the scale of rotation in these fields:

 Data entry mode:
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This way you can rotate an object by exactly 90 degrees or move an object along (the corner points of) a
grid.  

Press F3 or click on the  icon to change the minimal step for rotation/moving of elements. 

Note: Any number of changes made to your plan in 3D mode can be undone by the Undo icon.

8.4.3 Making changes by overwriting data

It is also possible to make changes to your project by the  icons seen at the
bottom of the 3D window.

·  With this icon you can open the 2D dialog of the selected object. You can also open this dialog
simply by double clicking on an object. Within this dialog parameter values of the object can be
overwritten.  This can also be done in the case of selecting a group of objects together.

·

Click on the arrow cross and move the selected object by entering numerically the scale of shifiting. Click
on the small green pipe to the right to apply the entered values.

· Rotation:  

After clicking on the  icon you can enter the scale of rotation numerically.
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· Size:
Changing the size of objects.

 

Define/modify the size of objects by entering values into the fields X, Y, Z.

  Apply the data you entered.

 Remove the selected object.

 Undo/Redo

8.4.4 Using the mouse to modify objects

Move the mouse over an object and left click to move it (hold the mouse button down to drag it
along). You can move around objects freely, or along the axes of the coordinate system if you

click on the  icon. Holding down Shift (X, Y axis) or Ctrl (Z axis) has the same effect.
You can see the properties of the selected object and how much you moved it (etc) in the info-
line at the bottom of the screen.
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If you move the element the scale of shift can be see (along the X, Y and Z axes), whereas if
you rotate it, the degree of rotation.

If you move the mouse along the selection frame the   icons may appear. Click on
these and move the selected corner of the object to resize it.

 Keep ratio: switch this option on and manual resizing will be done by keeping the
proportions of obejcts unchanged.

8.4.5 Rotating objects manually using the mouse

Rotation: the rotation axis is the axis of the object. Rotate the object by moving the cursor to an edge  of
the object, press down the left button of the mouse and moving it in the desired direction. 

 - for example, the vertical edge makes it possible to rotate the object along the Z axis, that is in the X-Y
plane. In this case the axis of rotation is the Z axis inserted into the big axis point.

8.5 Changing External Options

 You can change other options as you work with your 3D view. For example, you can change

perspective distance and rotation parameters. Click the  Settings icon to make these, and other,
changes.

The Settings dialog box will appear. The options are described below. Click “OK” when you’ve made all
the desired changes.

8.6 Saving the 3D View

 You can save wireframe and hidden line renderings in 3D EyeWitness as .DXF (3D
DXF!!), .BMP, .JPG, .WRL or WRZ, Google Earth .KMZ  files. You can save painted views as
.BMP, .JPG, .MOV, .WRL or .WRZ files. When you click the Save icon, the Save dialog box appears,
and you must specify a filename.
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8.7 Printing the 3D View

You can print from any perspective or angle in the 3D views in 3D EyeWitness. Once you have the desired

view, follow these steps to print:

1. Click the  Print icon

2. Select the options you want in the Print dialog box that appears.

3. Click “OK.”   

8.8 Background image

3D EyeWitness contains a feature where you can place the scene of your background image in the setting of your
photo. These images are accessed from the 3D EyeWitness CD by following these directions.

1.   Click the background image icon .

2.   In the dialog box that opens, you can select a .BMP or .JPG picture.

5.   Double click on the desired  background image. The selected image will appear behind your 3D

rendering. Move the 3D scene

6.   To clear the  background image, click the  Hide  background image icon .

8.9 RayTrace

RayTracing is a technique for image creation that is capable of producing high-quality, photo-realistic

images. It does, however, require significantly longer calculations than the usual polygon rendering
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techniques. Special 3D hardware available for personal computers implements some simple rendering

methods, but, unfortunately, none of them help with rayTracing. The speed with which rayTracing is

carried out ultimately depends on the power of your processor (CPU). Although rayTracing doesn't require

much memory, setting up some virtual memory is a good idea, especially if you work with big sketches.

8.9.1 Advantages of RayTracing

RayTracing  provides  better  quality  than  the  OpenGL rendering  system primarily used in the program.

Using standard methods, it is not possible to achieve images with realistic lighting, shadows, and

reflections, and with good smoothing (anti-aliasing).

8.9.2 Disadvantages of RayTracing

The only disadvantage of rayTracing is its longer computation times. With 3D hardware using standard

polygon rendering, computation times are so short that you can walk through your sketch interactively.

With rayTracing, compu- tation can take up to several minutes, depending on the complexity of the

sketch, the image settings, and the resolution of the picture.

8.9.3 How to Trace a Picture

After you have set up the desired view of the sketch, click on the RayTrace icon . You will see an
initialization screen while the program loads the data and does some calculations. If you work with really
big sketches and you do not have enough memory, the program may stop, displaying the "Out of memory"
message. It is then necessary to allocate more virtual memory.
After the initialization process is completed, you will see the ray trace win- dow. If you want to change the

 resolution (the size of the picture) or the quality settings of the picture, select the Options menu. When you

have set these op- tions, you are ready to start the rayTracing process by selecting the RayTrace menu

item. A progress indicator box will come up, and you can watch the image gradually fill in. If you want to

change any option and restart tracing, you can always stop the process by clicking on the Cancel button. The

progress indicator box will continuously show the calculation completion percentage, the elapsed time, and

the estimated remaining time.

When the calculations are complete, the picture will be presented in the main window. Although the

options must be set before tracing, you may still alter the finished picture after tracing. Using the Image

menu, you can will see some parameters which can still be changed. When you are satified, Save or Print

the finished picture.

Note: you can save or print several versions of the picture made with different settings of the
Image menu.

8.9.4 The Tracing Options

In the Options menu, you can change the size of the image and set the quality parameters of the picture.

Note: these options must be set BEFORE tracing.
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8.10 3D MovieMaker

The 3D MovieMaker in 3D EyeWitness lets you create a movie from a sequence of camera shots. You

can save this movie and replay it over and over as a way to walk through the scene.

Creating a movie is a simple, three step process, as explained below. First, you place the cameras to take the

picture frames, then create the movie (you’ll have many options here depending on what type of movie

you desire) and, finally, play the movie.

8.10.1 Placing the Cameras

1. Select Place Camera from the 3D menu. A colored outline of a camera will appear indicating the

field of view.

2. Place the camera in position to capture the first frame of the movie. Rotate the camera using your “+” or

“-” keys until it faces the direction that you want. Remember, pressing “F3” will rotate the camera in

increments of 5 degrees.

3. Click to anchor the camera view.
4. You  will  still  have  the  colored  outline  of  the  camera  attached  to  your cursor. Move and rotate the

camera into position to capture the next frame, and click to anchor it.

5. Choose one of the following approches:
a) Define the remaining shots manually by moving the camera, placing the shot, and clicking the

mouse until you have captured all the frames you want. Click the right mouse button when you are

done to escape the Place Camera function.

Note: The more shots you take and the closer together the shots are, the more fluid your movie
will seem. However,  increasing  the  fluidity  will  increase  the length of time it takes to create the
movie.

Choosing this approach, your scene will look something like this:
b) Let  3D  EyeWitness  enter  a  series  of  camera  shots  by  selecting  the second  camera  placed  and

 then  double-clicking  on  it  to  open  the Camera Setup dialog box. Change the options in the

dialog box and click “OK” when you are finished.
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Camera Direction: Indicates the direction the camera is pointing.
Vetrical Angle: The camera angle in the vertical plane. To look down- ward, enter a negative number.
To look upward, enter a positive num- ber.
Aperture Angle: Indicates how wide the view will be. The higher the number, the wider the view.
Vertical shift:: The height of the camera above the floor.

 

Note:  You  can  alter  individual  camera  shots  in option “a” by double-clicking a selected
camera to open the Camera Setup dialog box.

8.10.2 Creating the Movie (*.AVI,*.FLV,*.SWF)

1. Select Create Movie from the 3D menu. The Create Movie Parameters dialog box appears.

2. Click “OK.” The 3D EyeWitness MovieMaker dialog box appears.

Set  parameters / Number of frames per second: Decrease this number to slow down the speed of

the movie. 
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3. Click “Start”. Each frame will appear in the dialog box as it is generated. This may take a few minutes

depending on how many frames you cap- tured.

4. When all the frames have been generated, the Video Compression dialog box appears. Click “OK.” The

.AVI file will then be created.

8.10.3 Playing the Movie

1. Select Play Movie from the 3D menu. The Media Player will appear. Just below the Media Player is

the screen that will show the movie.

2. Click “Play” to run the movie.

8.11 Animation

Two kinds  of animation are  pos s ible  in 3DEyewitnes s : s ta tic camera  and dynamic camera
animation. 
***

8.11.1 Creating animations

Creating animation models of traffic accidents and crime scenes is easy with 3D EyeWitness. First, enter
the relevant information about the event: the individuals involved, vehicles, speed and direction of
movement, etc. From this data 3D EyeWitness creates an animation, which can be viewed from a variety of
perspectives. The camera may either be static or move along a path you specify. Set the camera inside a car,
for instance, to gain new insight on a traffic accident. Who could see the accident unfold and to what
extent? 3D EyeWitness offers you the tools to investigate these questions and more. Try it once and you'll
agree - 3D EyeWitness is an indispensable tool for today's emergency management and law enforcement
professionals. 
The objects to be used in the animation can be taken from the symbol library. These symbols (cars, people,
weapons, etc.) may be resized, given colors and patterns, and otherwise modified. It is also possible to
animate these symbols moving along a path. To do so, the path must be determined on the floor plan.  The
following example illustrates the steps needed to set a path for an animated symbol.  
1. Choose a symbol from the library
2. Specify the dimensions of the object (x-size, y-size, z-size), its position (Vert.shift.) and color (using

the  icon). The symbol may be rotated using the rotation icon, or the + and – keys. The angle of
rotation applied appears at the bottom right of the screen. The default value is 45, but by clicking on the
[45] this value may be modified. The symbol is placed on the plan by left clicking on the mouse. 

3. Rotating in space: The symbol may be rotated not only on the 2D plan, but also in 3D space. To do this,
first select the symbol and then select the 3D rotation menu from the right-click menu.  From here it is
possible to specify the angle of the symbol’s rotation.  The Axis z value describes the symbol’s degree
of rotation along the z-axis. The Axis x value describes the rotation around the x-axis. 
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4. Click on the  icon.  The motion of the object is set by first clicking on  the symbol, then drawing
lines using the same technique used to draw other types of lines. The object’s path is drawn on the 2D
plan. In this dialogue box the symbol’s movement along the path may be defined in more detail. To
view this dialogue, select the path, then double click to open the Symbol Route Settings dialogue box. 

5. In the first window of the dialogue box the following information may be viewed and altered: 
˙ Position & Size X,Y,Z: In the position field the path data is specified. Here the dialogue takes the X

and Y values from the symbol’s position on the plan.  The path’s elevation or slope can be specified as
the Z value. By selecting the Average function, the program will automatically calculate a Z value
from the given X and Y values. 

˙ In the Axis x,   Axis y,  Axis z fields the symbol’s angles during movement may be specified. If you
wish the symbol to alter its angular values in order to follow the direction of the path, select the Use
Route direction parameter. The sliding control can be used to specify when the object begins to turn in
order to follow a change in path direction. If this is set to minimum, then the object begins to turn in
the direction of a new segment already at the beginning of the previous segment.  If this control is set
to maximum, then the object will change orientation only at the intersection point of the two line
segments. If the Use Direction parameter is switched off, then the changes in the symbol’s angular
orientation may be written in individually. Here too automatic calculations may be requested by
switching on the Average function. 

˙ Speed: The symbol’s speed may be set for each path segment.  The Average option will calculate an
average speed if given starting and ending speed values.  

˙ Waiting time: The symbol may be made to stop for a defined time at segment end points. Also one
may specify whether the symbol is to be visible before or after these delays. 

˙ Time: In the duration field specify the amount of time needed for each path segment. In the case of
multiple animated symbols this function is very useful in a determining the delay values for each. 

˙ Mirroring interval: It is possible to reflect a symbol about its own axis at with a given frequency.
This is the easiest way in which to, for example, depict a walking figure. 

Path: The path may be designated as visible or invisible. If visible, the color may also be specified. 
Arrow: Directional arrows may be placed for each path segment. The size, color, and placement of these
arrows may be specified in the dialogue box. 

8.11.2 Static camera animation

To generate an animation planned on a 2D drawing, first open the 3D mode by clicking the  icon.
The point of view for the animation can then be adjusted on the 3D image by rotating and moving the 3D

image. Clicking the  icon will generate the animation.
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8.11.3 Dinamic camera animation

To create an animation with a dynamic camera, first cameras are placed on the 2D floorplan along the
intended path. If we wish the camera to travel along the path of a road for instance, we may place the first
camera inside the car and then give it a speed equal to the car’s. In this way the animation will record
action as it appears from the moving car. 
In the Create Movie / Options dialogue we may set Animation Playback. Without this feature the
camera moves along the path, without moving the specified symbols.  Here the screen size may be set
(Resolution: Width, Height). 
See:  motorist2.avi and  MOTORORISTS.MYH
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9 AVATAR

System requirements

Minimum

˙ Windows 7 or newer

˙ Microsoft .Net 3.5 or newer

˙ DirectX 9.0c 2010 June

˙ OpenGL

˙ vcredist

˙ + 500 MB RAM to the Avatar module

˙ video card: ShaderModel 2.0 support

˙ processor: 2 GHz or better

AVATAR runs

9.1 How to start the AVATAR

˙ In 3D Eye Witness 2D editor: in the menubar click the Avatar icon.

˙ In 3D Eye Witness 3D editor: in the menubar click the Avatar icon.
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˙ In 3D Eye Witness 2D editor: in the main menu click the 3D menu item, and in the submenu click

the Avatar play item.

˙ You can start 3D Eye Witness Avatar directly: open My Computer and navigate to the directory

where you installed 3D Eye Witness. Navigate to the sub directory Vision, then exe, then Release

and start VisionEditorClassic.exe.

[!] If you start Avatar directly it won't load any scene automatically, but you can load a previously saved

scene by clicking File main menu then Load sub menu item. If you start Avatar from the 3D or 2D editor it

will automatically load the scene presented in the 2D / 3D editor.

9.2 Camera handling

Basic camera handling methods:

˙ Left click in the scene: it will select the object under the mouse – or if there's no object under the

mouse it will deselect the previously selected object.

˙ Hold pressed the left mouse button + move the mouse: it will rotate the camera around the

selected object (or around the center of the scene if no object selected).

˙ Mouse scroll or hold pressed the right button of the mouse + move the mouse up/down: it will

move the camera forward/backward.

˙ Hold pressed the middle mouse button or hold pressed the left and right mouse buttons + move the

mouse: it will move the camera in the direction you move the mouse (left, right, up, down).

[!] The rotation will be preformed around the selected object or around the scene's center if there's no

object selected.

[!] If you attach the camera to an object the rotation will be performed relative to the object until you

detach the camera.

9.3 Settings

Click Options in the main menu then Settings sub menu item.

[!] Settings will be saved automatically when you change a setting.

[!] Many settings can be changed only when a scene is already loaded.

With the tabs in the Settings scene you can change categories of the settings.

The settings, by tabs:

˙ General
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˙ Scene debugger: if you turn it on it will present some visual debugging in the scene (will

visually show the positions of the objects and their directions).

˙ Show debug overlay: presents some technical information about the scene, in the scene.

Information: triangle count of the scene, etc.

˙ Y synchronization time: avatar up/down synchronization time (in seconds). The default will

be fine mostly, if you want a more precise up/down synchronization decrement the setting.

˙ Application Path: the location of the program / application in the hard drive.

˙ Project Path: the location of the project directory in the hard drive.

˙ User Path: the location of the User directory in the hard drive.

˙ Graphics

˙ Object fill mode: defines how the objects will be filled. Options: Fill (default, totally filled),

Point (only the points of the objects will be drawn), Wire (only the triangles build up the

object will be drawn).

˙ Preferred renderer: OpenGL or DirectX. You can set the preferred renderer (almost every

time the renderer will be used, except when some error happens), which will manage the

drawings of the scene. OpenGL is the default, in most PCs it looks better, but sometimes it

has compatibility problems which case you can switch to DirectX.

[!] DirectX option is only available if you installed DirectX.

˙ User settings

˙ Help message about recording: if you turn it on will present a help message when you start a

recording.

˙ Warning at close: if you turn it on it will warn you at close / exit whether you totally sure

about or want to save the scene before.

9.4 Attaching camera to an object

Attach
Select (left click with the mouse) an object in the scene (it will indicate you selected it), then click main

menu item Camera and click Attach to object menu item in the submenu.

 
[!] The camera stays attached to the object until you detaches it.

Detach

Click Camera main menu item then click Detach from object sub menu item.

9.5 Video Recording

To start a recording session click the Record button (in the bottom of the window).
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[!] The recording will stop when you click the Record button again after you started a recording session (the

button's text will change to Stop if you started a recording session). This way you can move the camera,

select objects, etc. even after the scene animation is ended and these will be also recorded.

When you click the Record button it will present a recording settings window in which you can set some

parameters to the recording:

˙ Frames per seconds: this will specify how many frames (pictures or snapshots) will be taken in one

second. If you set it higher it will take more snapshots and the video will be smoother but it will

take more time to record and convert the taken snapshots to a video. Additionally: most of the

people can see only 25-30 frames per seconds so set this setting higher than 25 or 30 frames per

seconds won't affect the video's smoothness for most of the people.

˙ Priority: options are speed and quality. Speed is the default. This case the program tries to take the

snapshots as fast as it can. If you set quality as priority then the program will try to make a

snapshot as detailed as it can. Speed is preferred because it's quality is also sufficient in most of

the cases (the video conversion will degrade the image quality anyway) and it's much faster than

the quality setting.

To accept the settings click the OK button. If you click the Cancel button the recording won't start.

After you clicked OK in the recording settings window it will optionally (you can turn it off in the settings

or by uncheck the checkbox in the warning window) show a warning window about the recording won't

stop until you press the Record button again (if you start a recording session the button's text will change to

Stop).

To stop the recording click the Record button again (if you start a recording session the button's text will

change to Stop). After you clicked the button it will show a video settings window in which you can set the

final video's (which will be stored on your hard drive) settings, for example the format of the video (AVI –

which means .avi file, Flash video – which means .flv file, …), the quality of the conversion (kBit/s –

which means kilo bits per seconds) and some other options.

After you set these settings click OK to start the video conversion and to save the final video to your hard

drive (the exact location will be asked when you click the OK button).

After the conversion you can freely copy, move or delete the video file.
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10 Road and Junction Designer

The road designer module is ideal for planning individual or connected roads. Joining the sections is realized

 graphically or by defining their data. Every section has some defining data and characteristic points:

the starting point, 

the central and

the ending points of the road.

The characteristic points of the starting and ending point are the length and the direction. With the middle

point, the location of the road can be modified. The easiest way to draw the road is by using the graphic icons

. 

The road can be designed by using straight, curved and round sections.

The following features can also be defined with entering the relevant data:
the number of lanes, the width of the lanes,

the length and the slope of the road-section,

the direction of the starting and the ending part of the road-section, the radius of the curve,

the location of the central point of the road by entering its (X and Y) coordinates,

markings on the road surface,

the width of the pavement which can be connected to the road-section. The whole construction can

consist of not more than 15 road sections.

The drawing screen of the road designer can be divided into 5 elements:

10.1 Upper Icons

 Settings Icon: The road-section is drawn according to the basic data which is entered here.

 Icon for Defining Colours: The colours of the given road-section, e. g. the color of the

pavement, the shoulder and of the road markings can be defined  with it.

Cm/Inch: You can set your unit of measure by clicking on the icon.

 New Plan: You can start a new project here.

 Open: By clicking on this icon you can look for files of already existing road-sections or whole

road-sytems. These files carry rhe extension of XDF.

 Save: You can save the plan here. The extension of the file is XDF.

Quit without saving.

Back to the 2-D scene designer.
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10.2 Graphical Editor Window

Here you can see the road-network under construction. When starting to build a road, different types

 of road-sections can be selected, then drawn graphically, and afterwards each can be
modified by selecting their characteristic points. After clicking on “Selection mode”  icon  you can
change the length and the direction of the road section by grabbing one of the ending points (driving the
cursor over it and holding the left mouse button).
By holding down the Ctrl key while selecting one of the ending points, you can prevent the direction of the

section from changing. For example, in case of a straight section the direction of the road will not change at

all, while in case of a curve the other ending point will remain stable. The data of the changes are recorded

in the appropriate line of the processing area. In the upper line of the graphic design window there may be

icons controlling the construction.

 Selection Icon : After clicking on it you can carry out changes on certain defining points of the

road section (i.e. moving with central point, lengthening by selecting a corner).

Zoom Icon : By holding the left mouse button down you can zoom on a given area, by

placing the magnifier glass shaped symbol over it, then you can move the area by the mouse.

10.2.1 Icon for constructing a Straight Road-Section

Straight Road-Section Icon
You can construct a straight road section according to the data in the settings by defining the two ending

points in the Graphic Construction Window. Each ending point can be defined by two separate single

clicks (not by holding down the button).

10.2.2 Icon for Constructing a Curved Road-Section

Curved Road-Section Icon
You can construct a curved road-section according to the data in the settings.
In case of a new section, and not a continuous drawing, you have to define 3 points of the curve. First the

 two ending points, then the third curve point. When you are in continuous drawing mode, the starting
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point and the direction of the curve is given, you only have to define the ending point by clicking with the left

mouse button.

10.2.3 Icon for Constructing Round Road Section

Round Road-Section Icon
You can construct a round road section by defining the central point and the radius. The full circle will be

constructed only if the radius is long enough for all lanes.

Note: Data chart can be used during graphic construction as well. The modification of a value is
recorded by the Enter button.  If  you  would  like  to  finalize  the  values  to  avoid redefinition by
moving the mouse, click  icon, located in the identification line (the upper line of the chart).

10.2.4 Continuous Road Construction Icon

Continuous Road Icon
Switched on this icon will enable continuous road construction. Straight curved road sections can be

constructed in alter. The program will record a curved section after each straight one automatically. You

can change this by clicking on the icon of the required type of road  You can interrupt continuous road

construction in the menu appearing after clicking the right mouse button or with the Esc key.

10.2.5 View Icons

View Icons
2D view icon: Used to construct the roads.

3D view icon: Used to view the constructed road(s). By holding the left mouse button, you can change

your view.

Note:  you can not construct your network in this mode.

10.3 Chart displaying the data of the road section

This  chart  offers  an  opportunity  for  you  to  define  the  road  sections  with specific data. The

modifications of the data willappear in Graphic Editor Window at once when you push Enter or click

on Refresh button.

Road sections can be defined by the following data:

10.3.1 Type

The type of the road can be chosen from the scrolling menu. A section can be straight, curved or round.

There is a maximum for the number of sections. Each  section  can  be  deleted  by  clicking  on  the  icon 

next  to  identification number.

Number of lanes: You can define the number of lanes within the section.

Width of lanes: You can define the width of the lanes.

Length: You can define the length of the road measure along the axis.

Ascent: The pitch or angle of the road can be defined. – under development (not yet available)

Starting and ending direction: The angle between the starting and ending point can be defined.

Radius: The radius of a curved road section can be defined.
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X,Y position: You can define the X and Y ordinates of the starting point of a section. 0,0 is in the

middle of the window.

10.3.2 Road marking

You can put markings between the lanes and the two sides of the road. These marking can be chosen from

the graphic menu appearing after clicking on the icon. Here you can give the colour of the markings as well.

The outline on the right will show the actual state. Clicking on the appropriate cell of the chart, the

marking on one side of the lane will change. This change can be eraesement of the marking, or choosing

another, frequently used one.

  
Shoulder

You can define the height and the width of the pavement connected to the road separately either on the left or

on the right side.

10.4 Set Corner Parameters Field

In the corner of junctions a small yellow bullet appears. After selecting it the bullet becomes red and data
appear for definition.

10.4.1 Type

You can define the type of the corner.
Sharp Turn: There is no extra turning area added, the corner is given by the two roads meeting in a

sharp turn.

Curved Turn: After giving the radius, a turning area is added to the corner at the meeting point of the

roads to create a curved turn.

Shortcut Turn: After giving the length of the connecting area, an angular turning area is added to the

corner.

In the scrolling menu you can choose which shoulder parameters shall the program use.
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10.4.2 Template

Junctions designed in advance make your work more effective. It is easier to create a required plan by

modifying these patterns than starting with a blank plan. The template to be loaded can be selected by

double clicking. After making your selection you can change the parameters of the pattern in the

graphical editor window and the data chart as usual.
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11 3D Modeler

3D EyeWitness includes a large number of predrawn symbols. For most crime and accident scenes, these

should be sufficient. For scenes that require that special table, car, murder weapon, or any other symbol,

you can create it from scratch using the 3D Modeler. You’ll also be able to modify any of the sym- bols in

the 3D EyeWitness libraries.

11.1 The Views

To properly assemble a symbol, you must look at it from three 2D vantage points as well as in a 3D
rendering. Below is the Modeler drawing screen with a symbol already created.
The views are:
Y-Z View: The head-on view of the symbol. X-Z View: The side view of the symbol.
X-Y View: The aerial view looking down on the top of the symbol.
3D View: The 3D perspective drawing of the symbol.
In all the views, you see a line drawing without regard to the transparancy of the various lines and solids in
the drawing. Also, individually, none of the 2D views offers any perspective with relation to the third
dimension.

11.2 The Toolbar

Like the main program, Modeler contains a toolbar above the drawing screen. Each function is explained

below. To see the name of any of the icons on the toolbar, position the cursor over that icon.

Select: Provides an arrow with which to select icons or parts of the drawing for modifying.

Cut: Cuts the selected object(s) to a special 3D EyeWitness clipboard. Copy: Copies the selected

object(s) to a special 3D EyeWitness clipboard. Paste: Copies the contents of the clipboard to the

Modeler drawing area.

The set of simple blue icons are used to create 2D elements that can be deco- rative, but have only length

and width. They are:

Line 
Polyline 
Polygon 
Triangle 
Rectangle 
Circle
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The 3D symbols are green symbols that have length, width, and height. These can be controlled to be a

complete solid or open at the top and/or bottom. The 3D symbols are:

Brick Pyramid Cone

Cylinder

Sphere

Hemisphere

In  addition  to  the  icons  for  drawing  elements,  the  toolbar  contains  two advanced buttons used to

transform 2D objects into 3D solids. An explanation of these two ocurrs later in this chapter. They are:

Solid of Revolution Axis
Prism Vector

The next two icons are functions that should be familiar to you from the 3D EyeWitness program. They

are:

Redraw
Zoom Window

The remaining icon is used to generate a full-screen 3D view of the symbol you are creating.

Total 3D

11.3 The Menu

There is also a menu above the icons in Modeler. Below is an explanation of the menu choices that are

new. The rest should be familiar to you from the 3D EyeWitness program or are explained previously in this

chapter.

From the File Menu
Open from Library: Use this function to open an existing symbol from a 3D EyeWitness library into

Modeler for custom modification.

Insert to Library: Use this function to insert the symbol created in Modeler into 3D EyeWitness. You

will be prompted to choose which library you want to insert the symbol. For best results, create a new

library for all your custom symbols by entering a new file name when prompted. Then, give a description

of the symbol and click “OK.” The symbol will then be added to the library you created.

Delete from Library: Use this function to delete a symbol from one of the 3D EyeWitness libraries.
From the Options Menu

Default Values: Each drawing element (brick, cone, line, etc.) is given a de- fault size and color. Use

this function to change the default size or color of any of the building elements for accuracy when

creating your new symbol.

Note: Select a surface texture for your new symbol from the symbol library in 3D EyeWitness.

11.4 Helpful Hints

Here are some hints to help in assembling your own symbol.

· When an element is selected, you can move it with the arrow keys on the keyboard as well as the

mouse. Use the arrow keys to move the element 1” at a time. Hold “Shift” down to move the element

in 1’ increments.

· Don’t worry about where you start building your object. By default, the first object you insert is in the

approximate center of the drawing field, allow- ing you plenty of room to build in any direction.
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· Rotate an element in the desired view with the “+” and “-” keys on your keyboard. The element will

rotate in increments of 5 degrees.

· When you are done with your symbol and it has been inserted into a library, you can modify its

entire dimensions before placing it into your scene, just like any other predrawn 3D EyeWitness

symbol.

· Whenever possible, modify an existing symbol. That way, some of the work will already be done for

you.

· Resize an element by moving the cursor to the red or green corners until the cursor becomes a two-

headed arrow. Hold the left mouse button down and drag the cursor to resize the element.

· If elements overlap, you can select an element by clicking on it and pressing “Ctrl” and “N” at the

same time as necessary to select the appropriate element.

· If you have multiple occurrences of the same object (such as table legs), create the first one and use

the Modeler copy and paste commands to replicate it. With this approach, the table legs will be exactly

the same size.

· As you move the cursor between the three 2D views, you will see where the element is placed in the

other views, including the 3D view. To make it easier to visualize the placement, one corner of the

 object is green and the opposite corner is red. The green corner corresponds to the same point in all

three of the 2D views.

11.5 Creating a Symbol

This section is a tutorial which will take you step by step through the creation of a desk. When you are

done, the desk will look like this:

1. Start by creating the desktop. Select Default Values from the Options menu and drag to the right to

select Brick. The Brick Setup dialog box appears. Enter these values and click “OK.”

X Size: 6’-0” 

Y Size: 3’-0” 

Z Size: 1”

You can also select a color for your desktop by clicking the color tile next to the word “Surface.”

2. Select the Brick icon and place the large rectangle in the center of the X-Y view so that it looks like the
picture below. To do this, you may need to rotate the rectangle in the Y-Z view.

3. Next, create the legs of the desk. Select Default Values from the Options menu and drag to the right to

select Cylinder. Make the following changes to Cylinder Setup dialog box.

Radius:    1”    
Height: 30”

Leave the other values as they are and click “OK.”
4. Select the Cylinder icon and place the cylinder in the X-Z view below the desktop. You will need to

rotate the cylinder by pressing the “+” or “-” keys on your keyboard so that it looks like the picture on

the next page.

5. Once one leg has been placed, use the Copy and Paste command to create the three other table legs and

position them as they are shown below. Or, repeat step 4.

Note: For greater accurracy in placement of the table legs, you can zoom in on the area.
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6. Next, we will create some drawers for the desk. Select Default Values from the Options menu and

drag to the right to select Brick. The Brick Setup dialog box will appear. Enter these values and click

“OK.”

X Size: 1’-6” 

Y Size: 3’-0” 

Z Size: 2’-0”

7. Select the Brick icon and place the rectangle under the desktop in the X-Z view and position it so the

edges of the rectangle meet the edges of the desktop in the X-Y view. The resulting desk should look

like the picture on the next page.

8. Save your new symbol. Select Save As from the File menu. Give the sym- bol a filename and click

“OK.”

9. Insert your desk to a new library for placement into your 3D EyeWitness scene. Select Insert to

Library from the File menu. Modeler will ask if you want to modify the 2D and 3D views. Click

“NO” for now. You can experiment with this later.

The Insert to Library dialog box will appear prompting you for a file name. For  best  results,  enter  a  file 

name  such  as  “Personal”  or  “New”  or “Custom” or anything other than one of the names of the

current libraries. Click “Open” after entering the file name.

The Symbol Settings dialog box will appear. Enter a symbol description and click “OK.” The symbol is

 now in your new library in the 3D EyeWitness program.

10.Now we will place your new symbol in a scene. Open 3D EyeWitness and open the scene you need.

Click the Symbols icon and then open any one of the symbol libraries by clicking an icon on the

secondary toolbar. That library will open. To open the library you just created, click the down arrow

next to the library name to bring up the list of libraries and click the name  of  the  library  you  just 

created  to  open  that  library. Your  custom symbol should be in that library ready for you to modify,

rotate, and place like any other 3D EyeWitness symbol.

11.6 Advanced Techniques

Solid of Revolution Axis and Prism Vector provide the tools needed to give a 2D element depth. Use
Prism Vector to give elements basic thickness. This could  be  very  handy  when  creating  a  deck  with 
irregular  sides.  Solid  of Revolution Axis gives elements cylindrical thickness. Both features work in
similar fashion.
For example, using the deck example, draw a 2D polygon in the X-Y view and select it with a left mouse

click. Select the Prism Vector icon. In the other two views, you will see a small green box and a dashed

line connected to the 2D polygon. The Prism Vector icon has also changed to a Prism icon.

Control the amount of thickness to give the element by moving the green box with the mouse or arrow

keys and then click the Prism icon. Modeler will transform the 2D element into one with three

dimensions.

Prism icon
To  create  exotic  figures  with  curves,  use  Solid  of  Revolution Axis.  For example, start by placing a 2D

triangle into the X-Z view and select it with the left mouse button. Select the Solid of Revolution Axis icon. A

dashed line with green and red boxes will appear and the Solid of Revolution Axis icon has changed to a

Vase icon.
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Anchor this dashed line with a single mouse click. Control the amount of thickness to give the

element with a single mouse click on either the red or green end of the line and adjust with the mouse or

keyboard arrows. Select the Solid of Revolution Axis icon which now looks like a vase to transform the 2D

element into a curve-based 3D element.

Solid of Revolution Axis icons
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12 Examples

12.1 Example - Drawing a wall

1. Select the Wall icon .

2. Select the Draw a single wall icon .
3. To draw a wall click anywhere within the design window to put down its to put down its first
corner point.
4. Move  the  cursor  to  set  the  wall’s  length  and  orientation.  The Space button acts as a toggle,
flipping the wall along a pivot line. Click to insert the other endpoint.

Note: You may manually enter specific coordinate values for a given element. Hit the „X” or „Y”
key on the keyboard and type the values into the X,Y fields.  
Note: By default, you may draw single walls only at 90 degrees to the x, y axis. To draw
walls at another angle, hit Ctrl+O or  
Shift Hold down when drawing a wall or other element in order to change your

orientation by 90º
Ctrl Hold down when drawing a wall or other element in order to change your

orientation by 45º
Shift+Ctrl Hold down when drawing a wall or other element in order to change your

orientation by defined (xº) angle in Ortho dialog                   

12.2 Example - Moving walls

1. Click on the Selection tool icon .
2. Select the wall you want to move. Left-click once on the wall.
3. Move the selected wall into its new position by holding down the left button and dragging the wall
manually.
4. Release the mouse button. 
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Note: You may manually enter the extent of repositioning by entering coordinates.  Hit  the  „X”  or
 „Y”  key  on  the keyboard and type the values into the X,Y fields. Hit the „L” key to change the
length of the wall.                                              
Note: If you click in the middle of a single wall, the entire wall can then be moved. If you click and
drag on one end of a free-standing wall, only the end point can be moved, while the other end of
the wall retains its original position.

12.3 Example - Resizing walls

1. Click on the Selection tool icon .
2. Select the endpoint of the wall you want to reposition. Left-click on the endpoint of the wall once.
3. Keep the mouse button pressed down and move the selected endpoint of the wall to its new
position.
4. Release the mouse button.
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Note: To change the wall parameters: Double-click on a  selected wall.                                        
                                                    
Note: When you click on a single wall of a rectangular set of walls that you entered as a group,
only the single wall is selected. You  may  now  move  this  wall,  thus changing the shape of the
rectangle as the other walls are automatically repositioned to adapt to the change. To select the
entire rectangle of walls, click on the Selection Tool icon and draw a selection box around the
walls. To draw a selection box, place the cursor at one corner of the selection box and then click
and drag the mouse to the opposite corner.

12.4 Example - Drag and drop a door or a window

1. Select the Door or Window icon .
2. Choose a Door or Window from the graphic library.
3. Optional: modify the size of the door or window before you insert it: Modify the door’s width,
height, or sill height in the library box.
4. Move the cursor over the wall where the door or window is to be installed. Click to see the
positioning rectangle, and move the rectangle to the exact location of the door/window. OR hit X or Y  and
type the distance from the endpoint of the wall in the Aperture position dialog box.
5. To change the swing of a door select the swing icon from the left side icons of the screen.

Note:  Inserting  multiple  doors  or  windows:  Use the  Serializing tab in the Aperture position
dialog box.

12.5 Example - Moving and resizing a door or a window

1. Click on the Selection tool icon .
2. Select the door or the window. Left-click once on the door.
3. Drag and move the selected door or window to its new place.
4. Release the mouse button.
5. Modify the door’s width, height, or sill height in the library box.

Note: You may manually enter the extent of repositioning by entering coordinates. Hit the „X” or
„Y” key on the key- board and type the values (by which the element is to be moved) into the
appearing Position dialog box.
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12.6 Example - Create a column

1. Select the Column icon .
2. Click on one of the three column icons to the left. 
3. Call the Column setting dialog box, click on the icon
4. Define the parameters of the column.
5. For rectangular and circular columns, a colored outline appears that moves with the cursor.
6. Click the cursor to insert the column.
7. Enter as many columns as you like and click on the right mouse button to finish the sequence.

12.7 Example - Create a slab

1. Select the Slab icon .

2. Click on one of the three slabs (  TOP,  ARBITRARY,  BOTTOM) ,  icons to the
left

3. Call the Slab setting dialog box, click on the icon .
4. Select the form of the slab: (Automatic, rectangular, polygon, circle) Define the parameters of the
Slab. x-Width and y-Width refer to the default size of rectangular slabs.
5. Draw the slab: Move the mouse and click  to set the corner coordinates as described below. Or, if

you use the icon    (Automatic slab generation for a room), simply click inside a room or outside a
bulding.
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Note:  If  you  are  drawing  a  rectangular slab,  a  rectangle appears.  The  upper-right  corner  is
 fixed  and  the lower-left  moves  along with  the  cursor. The  size  of  this  initial rectangle  is 
defined  by  the  x-Width  and  y-Width parameters. Change the slab’s size and shape, or slide
the cursor past the fixed corner to make it, for example, the lower-left corner. Click to out down
the slab.
Note: For a polygonal slab, move the cursor to the second corner  and  click  to  put it down.
Continue with as many corners as you like. To close the polygon, choose the first corner point
again and click, or double-click at the last point and the polygon closes automatically.

12.8 Example - Drag and drop a symbol

1. Select the Symbol icon .
2. Click on one of the symbols of library icons or roll down and select a library name from the
Library list in the Symbol library dialog box.
3. Click on the symbol you want to place.
4. Optional: you may modify the symbol before you insert it. In the Select Symbol library box, you
may change the symbol’s size, vertical shift, colors, textures and line styles.

5. Move the (outline of the) symbol with the cursor. Rotate the symbol by 45° using the 

icons or the + and - keys on the numerical keypad. Click on the  text or press Shift F3 to change
the rotation step to 5°. Click to insert the symbol.
6. You  have  the  option  of  entering  a  second  symbol  of  the  same  type. A symbol outline
appears again next to the cursor. Click on the right mouse button to escape from the drawing sequence.
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Note: Select a symbol, and right-click once and select 3D rotation from the popup menu, to set 
the 3D rotation parameters of a symbol (e.g. a turned over truck).
Note: If you want to create a modified , or a totally new symbol you may use the built-in 3D
MODELER. You may save the newly built symbols into your own library: File / Insert to library.

For the documentation of a scene you need to use the symbol library. You may choose from
hundreds of standard symbols such as doors, windows, rails, roads, stairways, traffic lights
and signs, cars, emergency vehicles, trains, fire protection symbols, commercial and military
aircrafts, and more. You may also create your own symbols (using the Modeler) and save
them for future use.

Clicking on the  icon opens the last used symbol library. The other libraries may be
opened from the Library listbox by using the secondary toolbar on the left side of the screen. In
the Symbol library dialog box there are 3D pictures on the buttons, from which you may select
the item you want to put into your project. The size and the color of the symbols are variable

and can be rotated by the  icons  or the +/- keys and the numeric keypad. Furnish the
office using the  SABLON and HOME OFFICE libraries.
Within the library you can move with the scrollbar. If the size of a piece of furniture is not
appropriate, you may change the parameters in the x-,y-,z-Size fields.
For the documentation of a crime scene you may use CRIME, GUNS1,  GUNS2,  GADGETS,
 etc.  libraries, for  an   accident scene TRAFFIC, ACCIDENT, AIRPLANE,  LX-CARS,
MACHINES libraries, for fire scenes FIRECARS libraries.

12.9 Example - Documentation of an accident scene

You may also document accident scenes with 3D EyeWitness. The  easiest  way  to  draw  the  scene, 

roads  and  intersections  is  to  use the  RoadCAD: Road Junktion Designer  module. It is
recommended that you work from a sketch of the scene.

12.9.1 RoadCAD

Road Designer allows you to  draw streets and intersections quickly. Click on the  ROAD
Designer icon. Here you may also specify lanes and other templates of streets and
intersections. You may modify the pre-drawn streets and intersections or use ROAD Designer
to draw your own. You may also set the slope of a road with the ROAD Designer module .
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For  the  documentation  of  an  accident  scene  you should use the ACCIDENT, AIRPLANE,
LX-CARS, MACHINES and TRAFFIC libraries. 
The most frequently used junctions can be found in the TRAFFIC library individually. Vehicles
(LX-CARS, MACHINES, FIRECARS, AIRPLANE), traffic lamps (TRAFFIC), and other items
generally found in accident scenes may be found in the ACCIDENT library.

  Note: with the  icon you may introduce traffic signs on the floor plan from the library of traffic
signs.

12.10 Example - 3D Documentation

With 3D EyeWitness you may automatically create any 3D view directly from your 2D diagram.
You may easily export 3D views both as picture files (BMP, JPEG, DXF) or in 3D format (WRL, WRZ,
3D DXF), and also as AVI, FLV or panorama (MOV) movie files.

The 3D images are textured and colored  or photorealistic ray-traced  pictures or line-drawings

 (DXF or specially formatted LDR).

You may send 3D line-drawings to the 2D editor with the  icon,  and save  it into .LDR files. You may
add texts, comments, dimension lines and more with the same tools you use when creating your scene in
2D.
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12.11 Example - Library expansion with Modeler

If you do not find a certain item in the library, you may create it yourself with the 3D Modeler module.

Items created this way can be added to your own library. 3D Modeler can be opened with the  icon in
the top toolbar.
Example: Create a new symbol out of an existing item taken from a library, and put it into a new library
called OWN, and then, finally, insert it into your project.
In File menu of 3D Modeler you may open the library you want with the Open from Library command.
With the arrow in the line Name, the names of the libraries can be displayed.

 

Take Car1A  from the ACCIDENT library for example. You can see 4 windows at a time in the Modeler
program. 

These are three views of the item together with a 3D axonometric projection in the left-lower corner. You
may create new items in the three view windows. As a quick example let us just rotate the object and put it
into our Own library this way.
To rotate the item you have to choose the window in which you can turn around the item with +/- keys.
You may save your modified symbol using the Insert to Library command in the File menu of the 3D
Modeler program.  If your own library does not exist yet, simply type in the (at maximum 8 character long)
name you want into the Name field of the Insert to Library dialog box.
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12.12 Handling Files

3D EyeWitness assigns the following extensions to files:
*.MYH Building  files.  Contain  floor-plan,  all  building  elements,  roof- structures, stairs and the terrain.
*.LDR Line-drawing files created by the 3D view functions of the program
*.DRS Drawing sheet files containing drawings from  *.MYH and *.LDR files (floor plans of different
floors, 3D views etc. )
*.TPL Drawing sheet template files (empty drawing sheets with frame, company logo etc.)
*.BMP, JPG,PNG Standard picture files for saving painted 3D views of your design. Click on the
Save toolbar icon to open the dialog box for saving one of these views.
*.WRL, WRZ, DXF,KMZ Files in 3D format.
*.AVI, FLV, MOV Movie files
*.DXF, 3D DXF This is a standard CAD file format. Save files in this format by selecting Export
from the File menu. These files can then be opened in many CAD programs.
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13 Hints & FAQ's

13.1 Hints

1.   The  arrow  keys  on  your  keyboard  can  be  used  for  wall  creation.  Hit “Enter” instead
of clicking your mouse button and press the arrow keys to move the crosshairs. Holding “Shift”
down while moving the crosshairs moves them in 1’ increments.
2.   For best results, create slabs last. Unless you change the vertical shift, it will automatically
fall to be the floor of the level you are on.
3.   Instead of trying to drag a wall to a new position/length, it is recommended that you delete
that wall and recreate a new wall in the desired location using the arrow keys as described
above.
4.   The “F2” key saves your scene automatically. Save often.
5.   To line up multiple levels, go to View/Layer and click the “Levels” tab. Click the Level you
wish to view at the same time as the current level.
6.   Placing slabs on the inside of your walls between levels will give you a more realistic 3D
rendering.
7.   For faster 3D renderings, go to View/Layer and hide some elements before generating the
3D view.
8.   Slabs can be resized and shifted to make other building elements like shelves, beams,
etc.
9.   Pressing the “F3” key allows you to create walls down to the 1/16th on an inch. Also, it
allows you to rotate objects in increments of 5 degrees.
10. To see your whole plan on the screen, select View/Zoom to Extents.
11. Enabling “Snap” turns on the smart cursor for easier editing.
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13.2 Frequently Asked Questions

Walls

Q: How do I add surface textures to a wall?
A: Double click on a selected wall. The Wall Settings/Visualization window will appear. Click on

the color slide for the side you want to add the texture. Choose the texture you want and click “OK”

twice.

Q: As I’m drawing my wall, I notice the wall is on the wrong side of my crosshairs. How do I

flip it to the other side?

A: Pressing the Spacebar will flip the wall to the other side of your crosshairs.

Q: How do I draw walls at angles other than 90 degrees?
A: Select Ortho from the Options menu. By pressing Shift or Ctrl while inserting an element you can

draw along the four axes (Shift) or by 45 degrees increments (Ctrl).

Q: I can’t seem to get my “Cut Wall” function to work. Why?
A: To cut a wall you need to position your crosshairs in between the two lines that make up the wall

and be at least 6” from a wall joint.

Q: Do I have to use the mouse to create walls?
A: No. Use the arrow keys on your keyboard to move the crosshairs 1” at a time and the “Enter”

button to anchor endpoints. Hold “Shift” down to move in 1’ increments. Or You can specify or

modify the position (or size) of an element you are editing by pressing X, Y, a,or d and entering

the desired values in the fields. After pressing one of these button the software switches into data

entry mode and in the fields dX, dY, a, d and you can enter values for a shift of X and/or Y, for an

angle of a, or a length of d.

Q: How do I extend/shorten a wall without having to redraw it?
A: Click the Edit arrow, then position the cursor so it is on the end of the wall. The cursor should become

a rectangle. Click and drag to the new wall length. If Snap (the fitting option) is on, and your cursor

comes close to a so-called ’hot-spot,’ one of several symbols will appear next to the selection arrow

or drawing pen to inform you of the precise position of the cursor. 

+ means that you are close to a grid-point (black +) or grid-line (white +)

a white pipe means that you are moving along the edge of a certain element (e. g. a wall)

a black pipe means that you are above a certain element's corner/angle-point (e. g. of a polygon or at

the end of a wall)

a small rhombus means that you are above the area of a polygon (e. g. a roof, column)

Grid Points

Q: How do I change the relative distance of the grid points?
A:  Go to Change Grid under the Options menu and enter new values. Make sure you click the

“Redraw” icon after clicking “OK.”
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Q: My grid points disappeared. What happened?
A:  User turned grid points off or they are too close together to view in present zoom mode. Zoom in or

select Change Grid from the Options menu and make sure “visible” is checked. Also, click

“Redraw” icon.
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Symbols

Q: How do I rotate symbols in increments of less than 45 degrees?

A: Before placing the symbol, press the “Shift F3” key. Then press the “+” or “-” keys or  icons
to rotate the symbol in 5 degree increments.

Q: How do I rotate a symbol once its been placed?
A: Select the symbol and hold the mouse button down on the symbol while pressing the “+” or “-”

keys on your keyboard OR  icons..

Q: How do I change the color of a symbol, or add a surface texture to it?
A:  After selecting the symbol from its library, click the  at the bottom of the library. A “Change

Properties” window will appear. Click on the color you wish to change and choose a new color or

 texture. Click “OK”, then place the symbol as you would normally.

Q: How do I delete a symbol?

A: Click the  “Selection Tool” icon. Then, click once on the symbol you want to delete so that it

becomes red. Press “Delete” on your keyboard.

Q: How do I highlight/select a symbol that is on top of another one?
A: Click on the symbol you want to highlight/select. Press the Spacebar to toggle between elements

on top of each other. Or The right button can be used to cancel / escape (Esc) a certain action in the

editing window or to bring up the Right Button Menu, which contains several functions. Selectable

items: the list of selectable items will appear, and the desired item may be selected from among

them. A small pipe indicates which item is currently selected. Another item may be selected from

the list by clicking on it with the left mouse button. 

Q: How do I edit a symbol once it has been placed in my scene?
A: Click the “Selection Tool” icon, then double click on the item you want to edit. The symbol library

 for that symbol will open. Make the desired changes and click “OK.”

Q: How do I place a symbol on top of another one? For example, a lamp on a table.

A: After selecting the lamp, change the “Vertical Shift” value to be the height (z-size) of the table.
Then position it over the table and click to anchor it.

Stairs

Q: Can I create a sprial staircase and how do I do it?
A: Yes, you can. This would need to be done in the 3D Modeler portion of the software. You will then

add that staircase into 3D EyeWitness by creating a new library. 

Q: How do I correctly install a landing for a split staircase?
A: Landings must be connected to two sets of stairs. Vertically shift the upper portion of the stairs to

the desired height. You have to define this vertical shift of the landing 

Dimension Lines

Q: How do I insert an automatic dimension line?
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A: First, use your crosshairs to select the wall you want to dimension. It will become highlighted.

Then, draw the dimension line parallel to and longer than  the  wall  you’ve  selected.  The 

dimension  line  will  appear  after entering the second point of the dimension line.

Q: How do I change dimension line styles?
A:  Select  Dimension  Settings  from  the  Options  menu.  Or,  click  the Dimensioning  icon  on  the 

top  toolbar. Then,  click  the  top  icon  on  the secondary toolbar that appears on the left side of the

Drawing Area.

Roofs

Q: How do I fill in the gable ends of my roof with walls?
A:  After the roof has been placed, go back and increase the height of the walls in your plan to that of the
top of the       roof. The roof will automatically cut those walls.

Q: How do I make a specific roof that is not in the roof library?
A: This needs to be done in the 3D Modeler portion of the software. You can start from scratch or

open a 3D EyeWitness roof symbol into Modeler and make the necessary modifications, then add

it back to your own custom library. 

Slabs

Q: Do I have to draw the slab first?
A: No. You can add the slab at any time. It will automatically become the floor of the level you’re

working on unless you change its vertical shift.

Q: How do I add carpeting to my floors?
A: A separate slab needs to be created for each section of carpeting. After the slab has been created,

double click on it to open the Slab Settings window. Click the color tile for “Top.” Choose the

carpet texture you want and click “OK.”

Printing

Q: Sometimes when I print, my plan is very small on the paper. What is causing this?

A: Most likely, you have an outlying elelment in your plan that needs to be deleted. To check this,

 select Zoom to Extents from the View menu. If your plan is smaller than the Drawing Area,

you need to scroll around and locate this outlying element and delete it.

Q: Does 3D EyeWitness print to scale?
A: Yes. 3D EyeWitness will print to any scale or will print as “Fit to Paper” and note the scale used on
the printout.

Q: Can I print my 3D views?
A: Yes, 3D EyeWitness allows you to print any 3D perspective rendered with the software.

3D MovieMaker

Q: The movies I generated are running too fast. Can I slow them down?
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A: Yes. To do this, change the number of frames per second in the “Create Movie” window to a

lower number before clicking “Start.”.

3D
Q: How do I position my camera on the second floor for a 3D Internal View? 
A: To position your camera on a floor other than the first, you’ll need to change the height of the camera

in the  Camera Setup window, adding in the height of the floor(s) below the one on which you want
to place the camera.

Zoom:

Q: Can I view my whole scene at one time even though it’s larger than the Drawing Area?

A: Yes. Select Zoom to Extents from the View menu or use the  Air view function..

Snap

Q: What is the Snap feature and why is it useful?
A: Enabling Snap will make walls and Slabs jump to the nearest gridpoint. This is helpful if you’d

like to line up the walls exactly on the edge of a slab.
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